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Simu Connect Desktop Client Overview 
 

Running on Windows and macOS, Simu Connect Desktop Client provides you with access 
to enterprise-grade telephony features from your computer desktop. 
 

Simu Connect Desktop Client layout 

Screen shoot 
 

1. Navigation bar 

2. Toolbar 

3. Workspace 
 

Navigation bar 

Navigation bar provides quick access to the following features: 
 

Feature Description 

Extensions • View colleague information. 

• Place audio or video calls to colleagues. 
• Leave voicemails for colleagues. 
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Feature Description 

 • Add colleague extensions to Favorites list. 

Contacts • View, add, and manage personal contacts. 
• View, add, and manage company contacts. 

Video Conferencing Initiate face-to-face meetings for instant communication among team 
members and customers. 
For more information, see Video Conferencing User Guide. 

 

Note: 

Simu Connect Desktop Client only provides a menu entry for the 
feature. When you access the feature, you will be redirected to the 
feature on Simu Connect Web Client without entering any 
credentials. 

Operator Panel Manage calls of members in a specific group. 

For more information, see Operator Panel User Guide. 

 

Note: 

Simu Connect Desktop Client only provides a menu entry for the 
feature. When you access the feature, you will be redirected to the 
feature on Simu Connect Web Client without entering any 
credentials. 

Call Center Console Handle queue calls and achieve real-time call monitoring, management, 
and reporting. 
For more information, see Call Center Console User Guide. 

 

Note: 

Simu Connect Desktop Client only provides a menu entry for the 
feature. When you access the feature, you will be redirected to the 
feature on Simu Connect Web Client without entering any 
credentials. 

Call Logs Check and manage your call logs. 

Voicemails Check and manage your voicemails. 

Recordings Check and manage your call recording files. 

Preferences Configure the following settings: 

• Extension profile 

• Extension presence 

• Voicemail 

• Audio and video 

• Function keys 

• Call-handling rules 
• Email notifications 

 

https://help.yeastar.com/en/p-series-linkus-cloud-edition/web-client-user-guide/video-conferencing-overview.html
https://help.yeastar.com/en/p-series-cloud-edition/operator-panel-user-guide/about-this-guide.html
https://help.yeastar.com/en/p-series-cloud-edition/call-center-console-user-guide/about-this-guide.html
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Feature Description 

 • Outlook integration 

 

Toolbar 

Toolbar provides quick access to common actions: 
 

Feature Description 

 
Quick access to download Simu Connect Mobile Client and Cloud One 
Simu Connect for Google. 

 
Use function keys to monitor status of specific objects or quickly perform 
specific operations via function keys. 

 
Switch between Desktop Client mode and CTI mode. 

Agent Status Change your status in a queue. 

 
Change extension presence. 

 
Place audio calls or video calls. 

Account • Change password 

• Configure two-factor authentication (2FA) 

• Check Privacy Policy Agreement 

• Access Simu Connect Help Center 

• Access Support Portal 

• Log out of your app name 

 

Workspace 

An area where you can view or manage specific features. 



 

 
 
 
 

Getting Started 
 
 

Log in to your app name 
 
 

Simu Connect Login Overview 

Simu Connect allows you to log in to Desktop Client using different methods, including 
logging in with your extension account via a login link, one-click login from Simu Connect 
Web Client, entering login information, or directly logging in with a third-party account. 
 

Extension account login 

You can log in to Simu Connect with your extension account using login link, one-click 
login, or manually-entered login information. 

Quick login 

• After you receive a Simu Connect welcome email, you can obtain a login link 

from the email, via which you can quickly log in to Simu Connect Desktop 
Client. 

For more information, see Log in to Simu Connect with Extension 
Account Using Login Link. 

 

• You can quickly log in to your Desktop Client from Simu Connect Web 
Client by just one click. 

For more information, see Log in to Simu Connect with Extension 
Account by One Click. 

 

Manual login 

You need to contact system administrator to obtain your username and pass-   
word, as well as the Simu Connect Server network information, then enter the 
information on Simu Connect Desktop Client to log in. 

For more information, see Log in to Simu Connect with Extension Account 
Using Manually-Entered Credentials. 
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Third-party account login 

If system administrator has integrated the server with a third-party system, you can directly 

log in to Simu Connect Desktop Client with the third-party account. 

For more information, see the following topics: 
 

• Log in to Simu Connect with Microsoft Account 

• Log in to Simu Connect with Active Directory Domain Account 

• Log in to Simu Connect with Google Account 
 

Log in to Simu Connect with Extension Account Using Login Link 

After you receive a Simu Connect welcome email, you can use the login link to quickly log 
in to Simu Connect Desktop Client with your extension account. 
 

Prerequisites 

You have received the Simu Connect welcome email. 
 

Note: 
 

• If you don't receive the Simu Connect welcome email, contact system 
administrator. 

• The login link is valid in 24 hours and can only be used once. 
 
 
 

Procedure 
 

1. In the Simu Connect welcome mail, copy the login link. 

2. Open Simu Connect Desktop Client, and click  at the top-right corner. 
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3. Paste the link on your app name, then click LOG IN. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Simu Connect detects the account information and asks if you want to log in with the 
account. 

4. In the pop-up window, click Confirm. 
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Note: 

If it is the first time that you log in to Simu Connect with extension account, 
you will be asked to agree a privacy policy agreement and change the initial 
password. When finished, you need to log in to Simu Connect with the new 
password. 

 
 

Log in to Simu Connect with Extension Account by One Click 

Cloud One supports one-click login for Simu Connect Desktop Client, you can conveniently 
access your Simu Connect Desktop Client from Web Client with just one click. 
 

Prerequisites 

You have installed Simu Connect Desktop Client on your computer. 
 

Procedure 
 

1. On Simu Connect Web Client, click  on the top bar, then click . 

https://www.cloudone.co/cloud-one-simu-connect-desktop-client


 

Simu Connect Desktop Client User Guide | 2 - Getting Started | 8 

 

 

 

 

 

 

 

 

 

Screen shoot 

A window pops up, asking if you allow the system to open the application. 

2. On the pop-up window, do as follows: 

Screen shoot 

a. If you want the system to open Simu Connect Desktop Client without asking again, 
select the checkbox. 

b. Click to open the Simu Connect Desktop Client. 

You are logged into Simu Connect Desktop Client without entering any credentials. 
 

Log in to Simu Connect with Extension Account Using Manually-
Entered Credentials 

This topic describes how to log in to Simu Connect Desktop Client with your extension 
account by manually entering login information. 
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Prerequisites 

Contact system administrator to obtain your username and password, as well as the do- 

main name of the server. 
 

Procedure 

 
 

1. On Simu Connect login page, enter the login information. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

a. In the Username field, enter your email address. 

b. In the Password field, enter the password associated with the username. 

c. In the Domain field, enter the domain name. 

2. Optional: Select or unselect the Auto Login option to decide whether to 
automatically log in to this account next time you open Simu Connect Desktop 
Client. 

3. Click LOG IN. 

4. If you have set up two-factor authentication, you need to enter an authentication code. 
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a. Enter the authentication code provided by an authenticator application or email. 

b. Optional: Select the checkbox of Trusted   Device. 
 

Note: 

For the device from which you log in most frequently, you can select the 

option to add it as a trusted device. In this way, you don't have to re-en- 

ter an authentication code with this device for the next 180 days. 

c. Click LOG IN. 
 

Note: 

If it is the first time that you log in to Simu Connect with extension 
account, you will be asked to agree a privacy policy agreement and 
change the initial password. When finished, you need to log in to Simu 
Connect with the new password. 

 
 

Log in to Simu Connect with Microsoft Account 

If system administrator integrates the server with Microsoft Entra ID (Azure Active 
Directory), you can log in to Simu Connect with your Microsoft account directly. 
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Requirements 
 

• System administrator has integrated the server with Microsoft Entra ID, and 
enabled Single Sign-on (SSO) feature. 

• Your Simu Connect version meets the following requirement: 

◦ Simu Connect Windows Desktop: Version 1.4.9 or later 

◦ Simu Connect Mac Desktop: Version 1.4.9 or later 
 

Procedure 
 

1. On Simu Connect login page, click  . 

You are redirected to the Microsoft sign-in page. 

2. Sign in to your Microsoft account. 

After signed-in, you are automatically logged in to Simu Connect Desktop Client. 
 

Log in to Simu Connect with Active Directory Domain Account 

If system administrator integrates the server with Active Directory (AD), you can log in to 

Simu Connect with your AD domain account directly. 
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Requirements 
 

• System administrator has integrated the server with Active Directory, and 
enabled Single Sign-on (SSO) feature. 

• Your Simu Connect version meets the following requirement: 

◦ Simu Connect Windows Desktop: Version 1.4.9 or later 

◦ Simu Connect Mac Desktop: Version 1.4.9 or later 
 

Prerequisites 

Contact system administrator to obtain the network information of Simu Connect Server. 
 

Note: 

The network information might be a domain name, or IP addresses and ports, de- 

pending on the Simu Connect Server's network configuration. 
 

Procedure 
 

1. On Simu Connect login page, enter the following information. 
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Scenario Procedure 

Figure 1. Log in using 
domain name 

If you obtain a domain name, do as follows: 

a. In the Username field, enter the username of your 

 AD domain account (Format: username@domainname).  
b. In the Password field, enter the password associated 

with the username. 

c. In the SN/Domain field, enter the domain name. 

 

Note: 

If the SN/Domain field is non-editable, click 

 and unselect Enable Custom Settings, 

then click Confirm. 

Figure 2. Log in using IP 

addresses and ports 

If you obtain IP addresses and ports, do as follows: 

a. In the Username field, enter the username of your    
AD domain account (Format: username@domainname). 

 .                                     , 

with the username. 

c. Click  . 

d. Select the checkbox of Enable    Custom    
Settings. e. Enter the IP addresses and ports. 

 

Note: 

When you use Simu Connect Desktop Client 
within company's Local Area Network (LAN), 
Simu Connect communicates through the local 
hostname/IP. Otherwise, Simu Connect 
communicates through the external 
hostname/IP. 

 f. Click Confirm. 

 

b  In the Password field enter the password associated 
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2. Click Login. 
 

Log in to Simu Connect with Google Account 

If system administrator integrates the server with Google Workspace, you can log in to 

Simu Connect with your Google account directly. 
 

Requirements 
 

• System administrator has integrated the server with Google Workspace, and 
enabled Single Sign-on (SSO) feature. 

• Your Simu Connect version meets the following requirement: 

◦ Simu Connect Windows Desktop: Version 1.12.4 or later 

◦ Simu Connect Mac Desktop: Version 1.12.4 or later 
 

Procedure 
 

1. Open Simu Connect Desktop Client. 

2. In the Domain field, enter the server address allowed for Google SSO. 
 

Screen shoot 

3. Click G and sign in to your Google account. 
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After signing in, you are automatically logged in to Simu Connect Desktop Client. 
 
 

Reset Simu Connect Password 

If you forget Simu Connect login password, you can reset password on Simu Connect 
Desktop Client. 
 

Procedure 
 

1. On Simu Connect Desktop Client login page, click Forget Password?. 

2. In the Forgot Password page, do as follows: 
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a. In the Extension Number field, enter your extension number. 

b. In the Email Address field, enter the email address that is bound with your 
extension. 

c. In the Domain field, enter the domain name of the server. 

d. Click Send. 

A password reset email is sent to your mailbox. 

3. In the password reset email, click the password reset link. 
 

Note:  

The link is valid for 30 minutes and can only be used once. 
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You are redirected to a Reset Password web page. 

4. On the Reset Password web page, enter your new password twice, and click Save. 
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The login password is changed. 
 

What to do next 

Log in to Simu Connect with the new password. 
 
 

Change the Display Language 

You can change the display language of Simu Connect Desktop Client as needed. 
 

Procedure 
 

1. Access the menu of Simu Connect Desktop Client based on your operating system. 

• For Windows: At the system tray, right click  . 

Screen shoot 

• For macOS: On the App menu, click Simu Connect Desktop Client. 

Screen shoot 

2. Select Settings from the menu. 
A Settings window pops up. 

3. In the Language drop-down list, select the desired language. 
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4. In the pop-up window, click Reboot Now. 
 
 

Set Simu Connect Desktop Client to Run at 
Startup on a Computer 

You can configure Simu Connect Desktop Client to automatically launch when your 
computer starts up. 
 

Procedure 
 

1. Access the menu of Simu Connect Desktop Client based on your operating system. 

• For Windows: At the system tray, right click  . 

Screen shoot 

• For macOS: On the App menu, click Simu Connect Desktop Client. 

Screen shoot 

2. Select Settings from the menu. 
A Settings window pops up. 

3. In the System section, select the checkbox of Auto Startup. 
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Result 

Simu Connect Desktop Client will automatically launch and run when your computer boots 
up. 
 

Note: 

If you have enabled Auto Login, your account will be automatically logged in 
when Simu Connect Desktop Client is launched. 

 
 

Log out of your app name 

This topic describes how to log out of Simu Connect Desktop Client. 
 

Procedure 
 

1. At the top-right corner of Simu Connect Desktop Client, click your account. 

2. In the drop-down list, click Log out. 
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Two-Factor Authentication (2FA) 
 
 

Two-factor Authentication (2FA) Overview 

Simu Connect Desktop Client allows you to configure two-factor authentication (2FA) for 
your account. With 2FA enabled, both your account password and an additional 
authentication code are required for Simu Connect login, which adds an extra layer of 
security to your account. This topic provides an overview of the supported two-factor 
authentication methods. 
 

Requirements 

System administrator has upgraded the server to 84.10.0.30 or later. 
 

Two-factor authentication by authenticator application 

This method requires you to install an authenticator application on your mobile phone. The 

supported applications are listed below: 
 

• Google Authenticator 
• FreeOTP 
• Twilio Authy 
• Microsoft Authenticator 

After installing an authenticator application, you need to add your account to the application, 
via which you can obtain authentication codes for two-factor authentication. When you log 
in to your account, both account password and the authentication code generated by the 
authenticator application are required. 

For more information about the configuration, see Configure Two-Factor Authentication 
Us- ing Authenticator Application. 
 

Two-factor authentication by Email 

This method allows you to receive authentication codes for two-factor authentication via 
the email that you use to log in. When you log in to your account, both account password 
and the authentication code sent to your email are required. 

For more information about the configuration, see Configure Two-Factor Authentication 
Using Email.

file:///C:/Users/USER/Downloads/84.10.0.30
https://support.google.com/accounts/answer/1066447?hl=en
https://freeotp.github.io/
https://authy.com/
https://www.microsoft.com/en-us/security/mobile-authenticator-app
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Configure Two-Factor Authentication Using 
Authenticator Application 

This topic describes how to configure two-factor authentication using an authenticator 
application on your mobile phone. 
 

Note: 

The configurations of two-factor authentication are applied to all your Simu Connect 
clients. 

 

Prerequisites 

You have installed one of the following supported authenticator applications on your mobile 

phone. 
 

• Google Authenticator 
• FreeOTP 
• Twilio Authy 
• Microsoft Authenticator 

 

Procedure 
 

1. At the top-right corner of Simu Connect Desktop Client, click your account, then go to 
Change Password & Security > Security Settings. 

2. Select the checkbox of Two-Factor Authentication. 

3. In the pop-up Password window, enter your account password and click Confirm to 

verify your operation. 

4. Select Authenticated by Authenticator. 
5. Add your account to the authenticator application via either of the following methods. 

 

Method Instruction 

Scan QR Code 

to quickly add the 
account 

You can quickly add your account to the authenticator application by 
scanning the QR code provided by Simu Connect Desktop Client. 

a. On your mobile phone, open the authenticator application, and 
select to scan QR code. 

b. Scan the QR code shown on Simu Connect Desktop Client. 

 

https://support.google.com/accounts/answer/1066447?hl=en
https://freeotp.github.io/
https://authy.com/
https://www.microsoft.com/en-us/security/mobile-authenticator-app
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Method Instruction 

 

 

Your account is added to the application automatically, a 6-digit 
authentication code is shown. 

Manually add the 
account 

In case you cannot scan the QR code, you can manually add your 
account and enter the secret key provided by Simu Connect Desktop 
Client. 

a. On Simu Connect Desktop Client, click Can't scan beside the QR 
code.    A secret key is displayed under the QR code, note it down 
for later use. 

 
 
 
 
 
 
 
 
 

b. On your mobile phone, open the authenticator application, and 
select to manually add an account. 

c. Enter the relevant information and paste the secret key. 

 

Note: 

If you need to complete more configurations for the secret 
key, you should set SHA1 as the algorithm for TOTP 
protocol, and set to generate 6-digit code with an interval 
of 30 seconds. 

Your account is added to the application, a 6-digit authentication 
code is shown. 

6. On Simu Connect Desktop Client, enter the 6-digit authentication code in the 
Authentication Code field. 

7. Click Save. 
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Result 
 

• The page prompts a message "Edited successfully.", which means that you have 
successfully set up two factor authentication. 

• Next time you log in to Simu Connect UC clients (Web Client, Desktop Client, and 
Mobile Client) using the email address and password of your extension account, you 
need to enter an authentication code additionally. 

 
 

Troubleshooting:  

What if I fail to log in with two-factor authentication? 

If you lose access to your two-factor authentication (e.g. you lost your device or 

could not receive authentication code via email), contact system administrator to 

disable the two-factor authentication for your account, so that you can directly log 

in with your email address and password. 
 

Related information 

Manage Two-Factor Authentication 
 
 

Configure Two-Factor Authentication Using Email 

This topic describes how to configure two-factor authentication using email. 
 

Note: 

The configurations of two-factor authentication is applied to all your Simu Connect 
clients. 

 

Procedure 
 

1. At the top-right corner of Simu Connect Desktop Client, click your account, then go to 
Change Password & Security > Security Settings. 

2. Select the checkbox of Two-Factor Authentication. 

3. In the pop-up Password window, enter your account password and click Confirm to 

verify your operation. 

4. Select Authenticated by Email, and complete the following settings: 
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a. Click Send. 
An email containing a 6-digit authentication code is sent to the email address 

that you use to log in. 
 

Note: 

The code expires 5 minutes after the email is sent. 

b. In the Authentication Code field, enter the authentication code. 

c. Click Save. 
 

Result 
 

• The webpage prompts a message "Edited successfully.", which means that you 
have successfully set up two-factor authentication. 

• Next time you log in to Simu Connect UC clients (Web Client, Desktop Client, and 
Mobile Client) using the email address and password of your extension account, 
you need to enter an authentication code additionally. 

 

Note: 

In later use, if the email address associated with your extension is changed, 

the two-factor authentication will be disabled automatically. 
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Troubleshooting: 

What if I fail to log in with two-factor authentication? 

If you lose access to your two-factor authentication (e.g. you lost your device or 

could not receive authentication code via email), contact system administrator to 

disable the two-factor authentication for your account, so that you can directly log 

in with your email address and password. 
 

Related information 

Manage Two-Factor Authentication 
 
 

Manage Two-Factor Authentication 

This topic describes how to manage the two-factor authentication feature, including 
removing trusted devices, changing authentication method, and disabling the two-factor 
authentication feature. 
 

Remove a trusted device 

In case you lost access to a trusted device, you can remove it from the list if necessary. 
 

1. At the top-right corner of Simu Connect Desktop Client, click your account, then go to 
Change Password & Security > Security Settings. 

The trusted devices are displayed in the Trusted Device List section. 
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2. Click  beside the device that you want to remove. 

3. In the pop-up window, click OK. 
 

Change two-factor authentication method 
 

1. At the top-right corner of Simu Connect Desktop Client, click your account, then go to 
Change Password & Security > Security Settings. 

2. Click  beside the current authentication method. 

3. Select the desired method, then complete the follow-up settings accordingly. 
 

Disable two-factor authentication 
 

1. At the top-right corner of Simu Connect Desktop Client, click your account, then go to 
Change Password & Security > Security Settings. 

2. Unselect the checkbox of Two-Factor Authentication. 

3. In the pop-up Password window, enter your account password and click Confirm to 

verify your operation. 

4. In the Security Settings tab, click Save. 
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The page prompts a message "Edited successfully.", which means that you have 
successfully disabled two-factor authentication. 

 

Related information 

Configure Two-Factor Authentication Using Authenticator Application 
Configure Two-Factor Authentication Using Email 



 

 
 
 
 

Extensions 
 
 

View Colleague Extensions 

This topic describes how to view colleague extensions and quickly reach colleagues. 
 

Procedure 
 

1. Log in to Simu Connect Desktop Client, go to Extensions. 

2. Optional: Select the group or department to which the desired extension belongs. 
 

Note: 

By default, all the extensions within the selected group or department are d 
is- played, whether the extensions are registered or not. You can choose to 
display only the registered extensions. For more information, see View 
Registered Extensions Only. 

 

• To select a group, click  at the top-left corner, then select one from the 
drop- down list. 

Extensions within the group are displayed. 
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• To select a department, click the desired department from the organizational 
tree. 

Extensions within the department are displayed. 

Screen shot 

3. To view details about a specific colleague, click the contact card. 
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4. Optional: Click specific icons to manage or reach colleagues. 
 

Icon  Description 

☆ 
 Add to the Favorites list. 

 

 
Note: 

• The Favorites list is displayed only when you add 
extensions to favorites. You can see the list by clicking 

 at the top-left corner. 

• For the colleagues whom you communicate with most 
often, you can add their extensions to the favorite list, 
so that you can quickly contact them. 

 
Place an audio call to the extension. 

 
Place a video call to the extension. 

 
Call mobile number. 

 
Leave a voicemail to the extension. 
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View Registered Extensions Only 

By default, all the extensions within the selected group or department are displayed on      
Simu Connect Desktop Client, whether the extensions are registered or not. You can 
configure to show only the registered extensions. 
 

Procedure 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > User > Status View. 

2. Unselect the checkbox of Show Unregistered Extensions. 

3. Click Save. 
 

View and Manage Colleague Extension's Calls 

An authorized user can instantly see which colleague extension's ringing or on a call, view 
names and IDs of the other party, and manage calls with just a few clicks from Extensions 
panel. This topic describes how to view and manage colleague extension's calls. 
 

Requirements 
 

• PBX Server: 84.16.0.25 or later 

• Simu Connect Desktop Client: 1.6.0 or later 

• Extension: Your extension has been assigned the Allow Call Operations in the 
Extension Page permission. 

 

Procedure 
 

1. Log in to Simu Connect Desktop Client. 

2. On the left navigation bar, click Extensions. 

The colleague extension that initiates a call or is on a call is marked with   , and the 

colleague extension that receives an incoming call is marked with   . 

file:///C:/Users/USER/Downloads/84.16.0.25
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Screen shoot 

3. Manage colleague extension's call as needed. 

• For colleague extension that initiates a call, you can click the call status 
label, then choose to hang up the call. 

Screen shoot 
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• For colleague extension that is on a call, you can click the call status label, 
then choose to transfer, park, monitor, or hang up the call. 

Screen shoot 

• For colleague extension that receives a call, you can click the call status 
label, then choose to redirect, pick up, or hang up the call. 

Screen shoot 



 

 
 
 
 

Contacts 
 
 

Contacts Overview 

Simu Connect Contacts provides an overview of your external contacts that are stored on 
the server. The Simu Connect Contacts is subdivided into two types, namely personally 
managed contacts (stored in Personal Contacts) and shared contacts (stored in Company 
Contacts or phone-book). 
 

Personal Contacts 

The Personal Contacts is only visible to yourself. You can store your own external contacts 
(such as direct customers) in it. 

For more information, see the following topics: 

• Add a Personal Contact 
• Manage Personal Contacts 
• Import and Export Personal Contacts 

 

Company Contacts 

The Company Contacts or phonebook is shared among authorized colleagues. You can 

store external contacts (such as company's customers, resellers, and partners) in it, so as 
to share contact information with your team members and thus enhancing team 
collaboration. 
 

Note: 

If you fail to see Company Contacts or specific phonebooks, it indicates that you 
don't have the viewing permission. Contact system administrator to grant you the   
permission if necessary. 

 

For more information, see the following topics: 

• Add a Company Contact 
• Manage Company Contacts 
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Favorite Contacts 

For contacts (both Personal Contacts and Company Contacts) that you are frequently or 

commonly communicated with, you can mark them as favorites. The marked contacts will 

be displayed in the Favorite Contacts list for quick location and retrieval. For more information, 
see Mark or Remove Favorite Contacts. 
 
 

Personal Contacts 
 
 

Add a Personal Contact 

This topic describes how to add a personal contact. The personal contacts you add will   
be synchronized across your Simu Connect UC Clients and are only visible to yourself, 
other colleagues cannot see your personal contacts. 
 

Supported methods 

Simu Connect Desktop Client supports to add a personal contact via any of the following 
methods: 

• Manually add a personal contact 
• Add a personal contact from call logs 
• Add a personal contact from Voicemails list 
• Add a personal contact from Recordings list 
• Add a personal contact from company contacts 

 

Manually add a personal contact 
 

1. On Simu Connect Desktop Client, go to Contacts. 

2. At the top-left corner, click , then select Personal Contacts from the drop-down 
list. 
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Screen shoot 

3. Click Add. 

4. On the contact details page, enter the information of the contact. 

5. Click Save. 
 

Add a personal contact from call logs 

You can directly add an unknown number from call log to your Personal Contacts. 
 

1. On Simu Connect Desktop Client, go to Call Logs. 

2. Right click the desired record. 

3. To add the contact as a new contact, do as follows: 

a. Click Add New Contact. 

You are redirected to a contact details page, and the number is automatically 

added to the number list. 

b. In the Add to drop-down list, select Personal Contacts. 

 

c. Edit the type of the number, and enter the information of the contact as needed. 

d. Click Save. 

4. To add the contact to an existing contact, do as follows: 

a. Click Add to Existing Contact. 

b. In the pop-up window, click  at the top-left corner, then select Personal 
Contacts. 
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c. Search and select an existing contact, then click Confirm. 

You are redirected to the contact details page, and the number is automatically 

added to the number list. 

d. Edit the type of the new number, and edit the information of the contact as 

needed. 

e. Click Save. 
 

Add a personal contact from Voicemails list 

You can directly add an unknown number from Voicemails list to your Personal Contacts. 
 

1. On Simu Connect Desktop Client, go to Voicemails. 

2. Right click the desired record. 

3. To add the contact as a new contact, do as follows: 

a. Click Add New Contact. 

You are redirected to a contact details page, and the number is automatically 

added to the number list. 

b. In the Add to drop-down list, select Personal Contacts. 

 

c. Edit the type of the number, and enter the information of the contact as needed. 

d. Click Save. 

4. To add the contact to an existing contact, do as follows: 

a. Click Add to Existing Contact. 
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b. In the pop-up window, click  at the top-left corner, then select Personal 
Contacts. 

 

c. Search and select an existing contact, then click Confirm. 

You are redirected to the contact details page, and the number is automatically 

added to the number list. 

d. Edit the type of the new number, and edit the information of the contact as 

needed. 

e. Click Save. 
 

Add a personal contact from Recordings list 

You can directly add an unknown number from Recordings list to your Personal Contacts. 
 

1. On Simu Connect Desktop Client, go to Recordings. 

2. Right click the desired record. 

3. To add the contact as a new contact, do as follows: 

a. Click Add New Contact. 

You are redirected to a contact details page, and the number is automatically 

added to the number list. 

b. In the Add to drop-down list, select Personal Contacts. 

 

c. Edit the type of the number, and enter the information of the contact as needed. 

d. Click Save. 

4. To add the contact to an existing contact, do as follows: 
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a. Click Add to Existing Contact. 

b. In the pop-up window, click  at the top-left corner, then select Personal 
Contacts. 

 

c. Search and select an existing contact, then click Confirm. 

You are redirected to the contact details page, and the number is automatically 

added to the number list. 

d. Edit the type of the new number, and edit the information of the contact as 

needed. 

e. Click Save. 
 

Add a personal contact from company contacts 

If system administrator has granted you the permission to manage company contacts, you 

can directly add a company contact to your Personal Contacts. 
 

1. On Simu Connect Desktop Client, go to Contacts. 

2. At the top-left corner, click , then select Company Contacts or the phonebook 
where the company contact is stored. 

 

 

 

 

 

 

 

 

 

Screen shoot 

3. On the contact card, click. . ., then click Add to Personal Contacts. 
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The page prompts "Added successfully", which indicates that the company contact is 

added to your Personal Contacts. 
 

Related information 

Manage Personal Contacts 

Import and Export Personal Contacts 
 

Manage Personal Contacts 

This topic describes how to edit and delete your personal contacts on Simu Connect 
Desktop 

Client. The changes will be synchronized across your Simu Connect UC Clients. 
 

Edit a personal contact 
 

1. On Simu Connect Desktop Client, go to Contacts. 

2. At the top-left corner, click , then select Personal Contacts from the drop-down 
list. 

3. On the desired contact card, click   . 

4. Edit the contact's information as needed, then click Save. 
 

Delete a personal contact 
 

1. On Simu Connect Desktop Client, go to Contacts. 

2. At the top-left corner, click , then select Personal Contacts from the drop-down 
list. 
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Screen shoot 

3. On the desired contact card, click. . ., then click Delete. 

4. In the pop-up window, click OK. 
 

Import and Export Personal Contacts 

This topic describes how to import and export personal contacts on Simu Connect Desktop 
Client. 
 

Export personal contacts 

You can export all personal contacts to a CSV file, and then make additions, removals, and 

changes to the file. 
 

1. On Simu Connect Desktop Client, go to Contacts. 

2. At the top-left corner, click , then select Personal Contacts from the drop-down 
list. 

3. On the top of the page, click Export. 

4. In the pop-up window, save the downloaded file to a desired location. 
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Import personal contacts 

We recommend that you export personal contacts data to a CSV file first, and use the file 
as 

a template to start with. In this way, you can save time and effort. 

Prerequisites 

Requirements of an imported file: 
 

• Format: UTF-8 .CSV 

• Size: Less than 300 MB 

• File name: Less than 127 characters 

• Import parameters: Ensure that the import parameters meet 
requirements. For more information, see Contacts Parameters. 

 

Procedure 
 

1. On Simu Connect Desktop Client, go to Contacts. 

2. At the top-left corner, click , then select Personal Contacts from the 
drop-down list. 

Screen shoot 

3. On the top of the page, click Import. 

4. In the pop-up window, click Browse, and select your CSV file. 

5. Click Import. 

The contacts in the CSV file will be displayed in Personal Contacts. 
 

https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/import-and-export-parameters-contacts.html
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Company Contacts 
 

Add a Company Contact 

This topic describes how to add a company contact. The company contacts you add will be 
synchronized across your Simu Connect UC Clients and the server, and be shared with 
other authorized colleagues. 
 

Requirements 

System administrator has granted you the permission to manage company contacts or 
specific phonebooks. 
 

Supported methods 

Simu Connect supports to add a company contact via any of the following methods: 
 

• Manually add a company contact 

• Add a company contact from call logs 

• Add a company contact from Voicemails list 
• Add a company contact from Recordings list 

• Add a company contact from personal contacts 
 

Manually add a company contact 
 

1. On Simu Connect Desktop Client, go to Contacts. 

2. At the top-left corner, click , then select Company Contacts or the phonebook 
where you want to add a company contact. 

3. Click Add. 
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4. On the contact details page, enter the information of the contact. 

5. Click Save. 
 

Add a company contact from call logs 

You can directly add an unknown number from call logs to Company Contacts. 
 

1. On Simu Connect Desktop Client, go to Call Logs. 

2. Right click the desired record. 

3. To add the contact as a new contact, do as follows: 

a. Click Add New Contact. 

You are redirected to a contact details page, and the number is automatically 

added to the number list. 

b. In the Add to drop-down list, select Company Contacts, then select the specific 
phonebook(s) where you want to store the contact from the Phonebook List. 

 

c. Edit the type of the number, and enter the information of the contact as needed. 

d. Click Save. 

4. To add the contact to an existing contact, do as follows: 

a. Click Add to Existing Contact. 

b. In the pop-up window, click  at the top-left corner, then select Company 
Contacts or the phonebook where the existing contact is stored. 

 

c. Search and select an existing contact, then click Confirm. 
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You are redirected to the contact details page, and the number is automatically 

added to the number list. 

d. Edit the type of the number, and enter the information of the contact as needed. 

e. Click Save. 
 

Add a company contact from Voicemails list 

You can directly add an unknown number from Voicemails list to your Company Contacts. 
 

1. On Simu Connect Desktop Client, go to Voicemails. 

2. Right click the desired record. 

3. To add the contact as a new contact, do as follows: 

a. Click Add New Contact. 

You are redirected to a contact details page, and the number is automatically 

added to the number list. 

b. In the Add to drop-down list, select Company Contacts, then select the specif- 
ic phonebook(s) where you want to store the contact from the Phonebook List. 

 

c. Edit the type of the number, and enter the information of the contact as needed. 

d. Click Save. 

4. To add the contact to an existing contact, do as follows: 

a. Click Add to Existing Contact. 

b. In the pop-up window, click  at the top-left corner, then select 
Company Contacts or the phonebook where the existing contact is 
stored. 
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c. Search and select an existing contact, then click Confirm. 

You are redirected to the contact details page, and the number is automatically 

added to the number list. 

d. Edit the type of the number, and enter the information of the contact as 
needed. e. Click Save. 

 

Add a company contact from Recordings list 

You can directly add an unknown number from Recordings list to Company Contacts. 
 

1. On Simu Connect Desktop Client, go to Recordings. 

2. Right click the desired record. 

3. To add the contact as a new contact, do as follows: 

a. Click Add New Contact. 

You are redirected to a contact details page, and the number is automatically 

added to the number list. 

b. In the Add to drop-down list, select Company Contacts, then select the 
specific phonebook(s) where you want to store the contact from the 
Phonebook List. 

 

c. Edit the type of the number, and enter the information of the contact as needed. 

d. Click Save. 

4. To add the contact to an existing contact, do as follows: 

a. Click Add to Existing Contact. 

b. In the pop-up window, click  at the top-left corner, then select 
Company Contacts or the phonebook where the existing contact is 
stored. 
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c. Search and select an existing contact, then click Confirm. 

You are redirected to the contact details page, and the number is automatically 

added to the number list. 

d. Edit the type of the number, and enter the information of the contact as 
needed. e. Click Save. 

 

Add a company contact from personal contacts 

You can directly add a personal contact to Company Contacts for contact-sharing with your 

team members. 
 

1. On Simu Connect Desktop Client, go to Contacts. 

2. At the top-left corner, click , then select Personal Contacts from the drop-down 
list. 

Screen shoot 

3. On the desired contact card, click. . ., then click Add to Company Contacts or 

Add to Phonebooks. 
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Note: 

The option varies depending on the server's subscription. 

4. If you select Add to Phonebooks, you need to select the specific phonebook 
where you want to store the contact in the pop-up window, then click Confirm. 

The page prompts "Added successfully", which indicates that the personal contact is 
added as a company contact. 

 

Related information 

Manage Company Contacts 
 

Manage Company Contacts 

This topic describes how to edit and delete company contacts on Simu Connect Desktop 
Client. 

The changes will be synchronized across your Simu Connect UC Clients and the server. 
 

Requirements 

System administrator has granted you the permission to manage company contacts or 
specific phonebooks. 
 

Edit a company contact 
 

1. On Simu Connect Desktop Client, go to Contacts. 

2. At the top-left corner, click , then select Company Contacts or the phonebook 
where the company contact is stored. 

Screen shoot 

3. On the desired contact card, click   . 
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4. Edit the contact's information as needed, then click Save. 
 

Delete a company contact 
 

Important: 

Think twice before you delete a company contact, because when you delete a 
company contact on your app name, the contact information will also be deleted on 
the server. 

 

1. On Simu Connect Desktop Client, go to Contacts. 

2. At the top-left corner, click , then select Company Contacts or the phonebook 
where the company contact is stored. 

Screen shoot 

3. On the desired contact card, click. . ., then click Delete. 

4. In the pop-up window, click OK. 
 
 

Mark or Remove Favorite Contacts 

This topic describes how to mark or remove favorite contacts on Simu Connect Desktop 
Client. 
 

Requirements 

Your Simu Connect version meets the following requirement: 
 

• Simu Connect Windows Desktop: Version 1.4.9 or later 

• Simu Connect Mac Desktop: Version 1.4.9 or later 
 

Mark a favorite contact 

You can mark the desired contacts as favorites for quick location and retrieval. 
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1. On Simu Connect Desktop Client, click Contacts. 

2. Find the desired contact, click. . . and select Add to Favorite Contacts. 

 

This contact is marked as favorites, which can be found in the Favorite Contacts list. 

Screen shoot 
 

Remove a favorite contact 
 

1. On Simu Connect Desktop Client, click Contacts. 

2. At the top-left corner of workspace, select Favorite Contacts from the drop-down list 

of  . 

Screen shoot 

3. Find the desired contact, click. . . and select Remove from Favorite Contacts. 
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This contact is removed from your Favorite Contacts list. 



 

 
 
 
 

Chat 
 

Internal Chat 
 

Simu Connect Desktop Client Internal Chat Overview 

Simu Connect Internal Chat (Instant Messaging, IM) feature allows you to start a 
conversation (either 1:1 or group chat) with colleague, and liven up the conversation with 
emoji, pictures,    and file sharing. 
 

Preview of Simu Connect Desktop Client internal chat 

Screen shoot 
 

Requirements 

PBX Server 

• Version: 84.12.0.32 or later 

file:///C:/Users/USER/Downloads/84.12.0.32


 

Simu Connect Desktop Client User Guide | 6 - Chat | 55 

 
 

• Plan: Enterprise Plan or Ultimate 
Plan Simu Connect Desktop Client 

• Version: 

◦ Widows Desktop: 1.2.14 or later 

◦ macOS Desktop: 1.2.10 or later 
 

Restrictions 
 

• Members per group chat: Max. 200 people 

• Group chat created (per user): Max. 100 group chats 

• File Sharing: Max. 100 MB 

• Chat history: Max. 1 year 
 

Highlights 
 

• Private 1:1 or Group Chat: Collaborate with your colleagues efficiently through a 
personal chat or a group chat. 

• Customizable Notification Settings: Enable or disable notifications (pop-up 
and sound) for new messages. 

• Chat History: Chat histories are auto-synced across Simu Connect UC Clients, 
which means   that you can access the same messages and files from Simu Connect 
Web Client and Simu Connect Mobile Client. 

• Flexible Message Type: Send text messages and emojis; Share files and 
pictures; Make an audio or video call within a click. 

 

Start a Chat Session with Colleagues 

For cases that do not require immediate attention, you can send instant messages right     
from Simu Connect Desktop Client to your colleagues without disturbing their work. This 
topic de- scribes how to start a one-on-one chat and a group chat. 
 

Prerequisites 
 

• Contact system administrator to check if PBX server meets the following 
requirements: 

◦ Version: 84.12.0.32 or later 

◦ Plan: Enterprise Plan or Ultimate Plan 

file:///C:/Users/USER/Downloads/84.12.0.32
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• Make sure that the version of your Simu Connect Desktop Client meets with the 
following version requirements: 

◦ Windows Desktop: 1.2.14 or later 

◦ macOS Desktop: 1.2.10 or later 
 

Procedure 
 

1. Log in to Simu Connect Desktop Client. 

2. On the left navigation bar, click Chat, then click the Internal Chat tab. 

3. To start a chat with a colleague, do as follows: 

 

a. At the left panel, enter a value (name, number, email address or a chat history) 

in the search bar to find the desired colleague. 

b. Click the matched colleague. 

4. To start a group chat with multiple colleagues, do as follows: 

a. Click + right beside the search bar. 
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b. In the pop-up window, select desired colleagues, then click Create. 
 

Note: 

Up to 200 members can be in a group chat. 
 
 
 

External Chat 
 
 

Simu Connect Desktop Client External Chat Overview 

Simu Connect External Chat feature allows you to centrally deal with customer queries 
(from different messaging channels, such as SMS or social media) on Simu Connect 
Desktop Client. 
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Preview of Simu Connect Desktop Client external chat 

 
 

Requirements 

PBX Server 

• Version: 84.12.0.32 or later. 

• Plan: Enterprise Plan or Ultimate Plan 
• Messaging: At least one messaging channel is set up on PBX. 

 

Simu Connect Desktop Client 
 

• Version: 

◦ Widows Desktop: 1.2.14 or later 

◦ macOS Desktop: 1.2.10 or later 
 

Channel types 

The external chats are marked with specific icons to indicate the type of the source channel, 

as listed below: 

 

file:///C:/Users/USER/Downloads/84.12.0.32
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• : The message is sent from SMS channel. 

• : The message is sent from WhatsApp channel. 

• : The message is sent from Facebook channel. 

• : The message is sent from Live Chat channel. 
 

Restrictions 

Learn about the restrictions of different messaging channels. 
 

 
SMS channel WhatsApp channel 

Facebook 
channel 

Live Chat 
channel 

Chat type Only support 1:1 conversation 

Session auto 
closure 

Depends on system 
administrator's 
configurations. 

Automatically close a     
messaging session that 
has been inactive for     
24 hours. 

Depends on system 

administrator's configurations. 

Messaging  
mechanism 

You can receive and 
reply to customers' 
inbound messages, and 
can initiate a messaging 
session. 

You can receive and reply to customers'inbound 
messages, but can NOT initiate a messaging session. 

File sharing Max. 100 MB Max. 25 MB Max. 10 MB 

File retention 
period 72 hours 

 

Highlights 
 

• All-in-one message inbox: Receive and manage all customers' queries across 
multiple messaging channels centrally in one place. 

• Customer contact using business number: Contact customers using a 
business phone number, while keeping your personal number private. 

• Seamless collaboration across colleagues: Transfer a messaging session to 
another colleague, the colleague can review the whole chat history and take over the 
messaging session without hassle. 

• Flexible session management: Supports management operations including 
elevating a messaging session to a call, archiving or unarchiving messaging 
sessions, and more. 
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• Customizable Notification Settings: Enable or disable notifications (pop-up 
and sound) for new messages. 

 

Instructions 

For more information about how to use the external chat, see Manage Customer 
Queries from External Messaging Channels. 

Related information 

Configure Chat Notifications 
 
 

Configure Chat Notifications 

This topic describes how to mute or unmute notifications for a specific chat, and how to 

configure new message notifications (pop-up and sound) for all Simu Connect chats. 

Mute or unmute notifications for a chat (specific setting) 
 

1. On Simu Connect Desktop Client, click Chat, then click the Internal Chat or 
External Chat tab. 

2. Mute or unmute notifications for the desired chat as needed. 

https://help.yeastar.com/en/p-series-cloud-edition/contact-center-guide/manage-customer-queries-from-external-messaging-channels-desktop.html
https://help.yeastar.com/en/p-series-cloud-edition/contact-center-guide/manage-customer-queries-from-external-messaging-channels-desktop.html
https://help.yeastar.com/en/p-series-cloud-edition/contact-center-guide/manage-customer-queries-from-external-messaging-channels-desktop.html
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Operation Instruction 

Figure 3. Mute 

notifications for a chat 

a. Right click on the chat. 

b. Click Mute notifications. 

The chat is muted and marked with ; 
You can still receive messages in the muted 
chat, but will NOT be notified upon receiving 
new messages. If there are new messages,  
the chat will be marked with a red dot 
instead of the number of unread messages. 

Figure 4. Unmute 

notifications for a chat 

a. Right click on the chat. 

b. Click New message notifications. 

When there are new messages, you will 
receive new message notifications. 
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Configure new message notifications (pop-up and sound) for all chats 
(global settings) 
By default, Simu Connect Desktop Client plays a sound and displays a pop-up when a new 
message arrives. You can decide whether to enable the notification or not, and the settings 
will be applied to both Simu Connect internal chats and external chats. 
 

1. Access the Settings menu of Simu Connect Desktop Client based on your operating 
system. 

 

Operating 
System Instruction 

Windows 
On the system tray, right click   > Settings 

 
 
 
 
 
 
 
 
 
 
 
 
 

. 

Screen shoot 

macOS On the App menu, click Simu Connect Desktop Client > Settings. 

Screen shoot 

2. In the Notifications section, change the chat notification settings as needed. 
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• New message notifications: If enabled, upon receiving a new message, you   
will see a pop-up notification displayed at the bottom-right corner of your desk- 
top. 

 

• Play sound for new messages: If enabled, upon receiving a new 
message, Simu Connect Desktop Client will play a sound to notify you. 



 

 
 
 
 

CTI 
 
 

Simu Connect Desktop Client CTI Overview 

Simu Connect Desktop Client can be used in softphone mode or CTI mode. This topic 
describes what is softphone mode and CTI mode and what call operations you can 
perform in each mode. 

Softphone mode 

A softphone is a software-based phone that is equivalent to a traditional desk phone, which 
allows you to make and receive calls over the Internet via a computer. A softphone not only 
has all the features of a deskphone, but also has additional features typical for online 
messaging, such as chat, video call, extension presence, etc. 

If you don't have a desk phone in the office, you can set Simu Connect Desktop Client to 
softphone mode. In this way, you can perform the following operations to manage phone 
calls on your computer: 
 

• Make/End a call 
• Make a second call 
• Answer/Reject a call 
• Mute/Unmute a call 
• Transfer a call (attended transfer and blind transfer) 
• Record a call 
• Hold/Resume a call 
• Swap hold 
• Add participant 
• Merge calls 
• Call flip 
• And more 

 

CTI mode 

Computer Telephony Integration (CTI) connects a computer with a telephone system, which 

allows you to manage phone calls right on a computer. 

If you prefer desk phone or Simu Connect Web Client for communication, you can set Simu 
Connect Desktop Client to CTI mode. In this way, Simu Connect Desktop Client acts as a 
visual control panel where you can perform the supported call operations, whereas calls 
are made and received from the connected desk phone / Simu Connect Web Client. 
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You can control IP phones and Simu Connect Web Client via Simu Connect Desktop Client 
CTI. Supported operations to manage calls via CTI vary from the connected endpoint. Refer 
to the following table for details. 
 

Note: 
 

• For CTI-compatible phones, see Compatible Yealink IP phones, Compatible    
Fanvil IP phones, Compatible Snom IP phones, and Compatible 
Grandstream IP phones. 

• Video call and function key are not supported under CTI mode. 
 
 
 

Table 1. Supported call operations 
 

 

Operations 
Compatible Yealink / 
Fanvil / Snom / 

Grandstream IP phones 

 

Other IP phones 

 

Simu Connect Web 
Client 

Make/End a call √ √ √ 

Make a second call √ × √ 

Answer a call √ × √ 

Reject a call √ √ √ 

Mute/Unmute a call × × × 

Blind transfer a call √ √ √ 

Attended transfer a 
call 

√ × √ 

Record a call √ √ √ 

Hold/Resume a call √ √ √ 

Swap hold √ × √ 

Add participant × × √ 

Merge calls × × √ 

Flip a call √ × √ 
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Table 2. Compatible Yealink IP phones 
 

Phone Model Firmware Version 

SIP-T21P_E2 52.84.0.125 or later 

SIP-T21_E2 52.84.0.125 or later 

SIP-T23P 44.84.0.125 or later 

SIP-T23G 44.84.0.125 or later 

SIP-T27G 69.85.0.5 or later 

SIP-T29G 46.83.0.120 or later 

SIP-T30P 124.85.0.15 or later 

SIP-T31 124.85.0.15 or later 

SIP-T31P 124.85.0.15 or later 

SIP-T31G 124.85.0.15 or later 

SIP-T33P 124.85.0.15 or later 

SIP-T33G 124.85.0.15 or later 

SIP-T31W 124.86.0.75 or later 

SIP-T34W 124.86.0.75 or later 

SIP-T40P 54.84.0.125 or later 

SIP-T40G 76.84.0.125 or later 

SIP-T41P 36.83.0.120 or later 

SIP-T42G 29.83.0.120 or later 

SIP-T46G 28.83.0.120 or later 

SIP-T48G 35.83.0.120 or later 

SIP-T41S 66.85.0.5 or later 

SIP-T42S 66.85.0.5 or later 

SIP-T46S 66.85.0.5 or later 

SIP-T48S 66.85.0.5 or later 

SIP-T41U 108.85.0.39 or later 

SIP-T42U 108.85.0.39 or later 

SIP-T43U 108.85.0.39 or later 

SIP-T46U 108.85.0.39 or later 

SIP-T48U 108.85.0.39 or later 

SIP-T44U 108.86.0.90 or later 
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Table 2. Compatible Yealink IP phones (continued) 
 

Phone Model Firmware Version 

SIP-T44W 108.86.0.90 or later 

SIP-T52S 70.84.0.70 or later 

SIP-T54S 70.84.0.70 or later 

SIP-T53 96.85.0.5 or later 

SIP-T53W 96.85.0.5 or later 

SIP-T54W 96.85.0.5 or later 

SIP-T57W 96.85.0.5 or later 

T64LTE 132.86.0.25 or later 

T67LTE 132.86.0.35 or later 

SIP-T56A 58.83.0.15 or later 

SIP-T58 58.85.0.5 or later 

SIP-T58W 150.86.0.5 or later 

VP59 91.85.0.5 or later 

AX83H 180.86.0.5 or later 

AX86R 180.86.0.5 or later 

 

Table 3. Compatible Fanvil IP phones 
 

Phone Model Firmware Version 

X1S/X1SP 2.2.12 or later 

X1SG 2.2.12 or later 

X3SG 2.2.12 or later 

X3U 2.2.12 or later 

X2/X2P 2.14.0.7386 or later 

X2C/X2CP 2.14.0.7386 or later 

X3S/X3SP/X3G 2.14.0.7386 or later 

X4/X4G 2.14.0.7386 or later 

X4U 2.2.11 or later 

X4U-V2 2.12.1 or later 

X5U 2.2.11 or later 

X5U-V2 2.12.1 or later 
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Table 3. Compatible Fanvil IP phones (continued) 
 

Phone Model Firmware Version 

X5S 2.2.1 or later 

X6 2.2.1 or later 

X6U 2.2.11 or later 

X6U-V2 2.12.1 or later 

X7 2.2.11 or later 

X7C 2.2.11 or later 

X7A 2.2.0.229 or later 

i56A 2.8.13 or later 

A32 2.6.0.408 or later 

A32i 2.6.0.408 or later 

A320 2.6.0.1402 or later 

A320i 2.6.0.1402 or later 

X210 2.2.11 or later 

X210i 2.2.11 or later 

X7-V2 2.12.1.3 or later 

X7C-V2 2.12.1.3 or later 

X210-V2 2.12.1.3 or later 

X210i-V2 2.12.1.3 or later 

V65 2.12.2.4 or later 

X3S/X3SP Lite 2.4.5 or later 

X3S/X3SP Pro 2.4.5 or later 

X3SW 2.4.5 or later 

X3SG Lite 2.4.5 or later 

X3SG Pro 2.4.5 or later 

X3U Pro 2.4.5 or later 

V62 2.4.10 or later 

V63 2.12.16.19 or later 

V64 2.4.10 or later 

V67 2.6.0 or later 

X301 2.12.2 or later 
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Table 3. Compatible Fanvil IP phones (continued) 
 

Phone Model Firmware Version 

X301G 2.12.2 or later 

X301W 2.12.2 or later 

X303 2.12.2 or later 

X303G 2.12.2 or later 

X303W 2.12.2 or later 

X305 2.12.1.6 or later 

X303-2 WIRE 1.0.3 or later 

W610W 2.12.0 or later 

W611W 2.12.4.8 or later 

V61G 2.12.18.8 or later 

V61W 2.12.18.8 or later 

V62G 2.12.18.8 or later 

V62W 2.12.18.8 or later 

V66 Pro 2.12.18.4 or later 

V66 2.12.18.4 or later 

V62 Pro 2.12.18.2 or later 

W710D 1.16.2 or later 

A308i 2.6.10.1177 or later 

H603W 2.14.0.11 or later 

V50P 2.12.20.4 or later 

V60P 2.12.20.3 or later 

V60W 2.12.20.3 or later 

 

Table 4. Compatible Snom IP phones 
 

Phone Model Firmware Version 

D120 10.1.54.13 or later 

D140 10.1.148.1 or later 

D150 10.1.148.1 or later 

D315 10.1.73.16 or later 

D335 10.1.73.16 or later 
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Table 4. Compatible Snom IP phones (continued) 
 

Phone Model Firmware Version 

D385 10.1.73.16 or later 

D710 8.9.3.80 or later 

D712 8.9.3.61 or later 

D713 10.1.73.16 or later 

D715 10.1.33.33 or later 

D717 10.1.73.16 or later 

D720 8.9.3.80 or later 

D725 10.1.175.16 or later 

D735 10.1.73.16 or later 

D785 10.1.73.16 or later 

D812 10.1.184.14 or later 

D815 10.1.184.14 or later 

D862 10.1.137.15 or later 

D865 10.1.137.15 or later 

SP800 10.1.169.15 or later 

 

Table 5. Compatible Grandstream IP phones 
 

Phone Model Firmware Version 

GHP610W 1.0.1.71 or later 

GHP611W 1.0.1.71 or later 

GHP620W 1.0.1.71 or later 

GHP621W 1.0.1.71 or later 

GHP630W 1.0.1.71 or later 

GHP631W 1.0.1.71 or later 

WP825 1.0.11.67 or later 
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Control a Yealink IP Phone by Simu Connect Desktop 
Client 
By enabling CTI mode on Simu Connect Desktop Client, a Yealink IP phone with your 
extension registered can be connected to your Simu Connect Desktop Client. In this way, 
Simu Connect Desktop Client acts as a visual control panel where you can manage phone 
calls, while calls are made and received using the Yealink IP phone. 
 

Applications 

This topic is applied to the Yealink IP phones that are compatible with Simu Connect 
Desktop Client CTI. 
 

Tip: 

For incompatible IP phones, refer to Control an Incompatible IP phone by your 
app name Desktop Client for instructions on phone control. 

 

Requirements 

PBX server 

The uaCSTA feature is enabled (Path: PBX Settings > SIP Settings > 
Advanced > Other Options > Enable uaCSTA Connection). 

IP phone 

The extension registered on the IP phone is the same as that of Simu Connect Desk- 

top Client. 
 

Note: 

Register only one account on the IP phone, or CTI feature may not 

work. 
 

Step 1. Set the IP phone to be controllable 
 

Note: 

If system administrator has assigned your extension to the IP phone via Auto 
Provisioning, your IP phone is ready for being controlled. In this case, you can 
directly enable CTI mode on Simu Connect Desktop Client. 

 

If system administrator has registered your extension to the IP phone manually, you need to 

set the IP phone to be controllable as follows. 

The following instructions take Yealink T56A as an example to show how to enable the CS- 

TA control function. 
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1. Log in to the phone web interface. 

2. Go to Features > Remote Control. 

3. On the Remote Control page, turn on the option CSTA Control. 

 

4. Click Confirm. 

5. In the pop-up dialog box, click OK to reboot the phone. 
 

Step 2. Enable CTI mode on Simu Connect Desktop Client 

Change Simu Connect Desktop Client to CTI mode, so that you can use Simu Connect 
Desktop Client to 

manage phone calls on your IP phone. 
 

1. Log in to Simu Connect Desktop Client. 

2. At the top-right corner, click   , then select the connected Yealink IP phone from the 

drop-down list. 
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Result 

You can do the following operations on the connected Yealink IP phone from Simu Connect 
Desktop Client: 
 

• Make/End a call 
• Make a second call 
• Answer/Reject a call 
• Record a call 
• Transfer a call (attended transfer and blind transfer) 
• Hold/Resume a call 
• Swap hold 
• Flip a call 

 
 

Control a Fanvil IP Phone by Simu Connect Desktop 
Client 

By enabling CTI mode on Simu Connect Desktop Client, a Fanvil IP phone with your 
extension registered can be connected to your Simu Connect Desktop Client. In this way, 
Simu Connect Desktop Client   acts as a visual control panel where you can manage phone 
calls, while calls are made and received using the Fanvil IP phone. 
 

Applications 

This topic is applied to the Fanvil IP phones that are compatible with Simu Connect 
Desktop Client CTI. 
 

Tip: 

For incompatible IP phones, refer to Control an Incompatible IP phone by your 
app name Desktop Client for instructions on phone control. 

 

Requirements 

PBX server 

The uaCSTA feature is enabled (Path: PBX Settings > SIP Settings > 
Advanced > Other Options > Enable uaCSTA Connection). 

IP phone 

The extension registered on the IP phone is the same as that of Simu Connect 
Desktop Client. 
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Note: 

Register only one account on the IP phone, or CTI feature may not 

work. 
 

Step 1. Set the IP phone to be controllable 
 

Note: 

If system administrator has assigned your extension to the IP phone via Auto 
Provisioning, your IP phone is ready for being controlled. In this case, you can 
directly enable CTI mode on Simu Connect Desktop Client. 

 

If system administrator has registered your extension to the IP phone manually, you need to 

set the IP phone to be controllable as follows. 

The following instructions take Fanvil X5S as an example to show how to enable the 
uaCSTA function and configure a uaCSTA number. 
 

1. Log in to the phone web interface, go to Line > SIP. 

2. In the Line drop-down list, select your extension. 

3. Expand the Advanced Settings menu, enter your extension number in the 
uaCSTA Number field. 

4. Expand the SIP Global Settings menu, select the checkbox of Enable uaCSTA. 

5. Click Apply. 
 

Step 2. Enable CTI mode on Simu Connect Desktop Client 

Change Simu Connect Desktop Client to CTI mode, so that you can use Simu Connect 
Desktop Client to manage phone calls on your IP phone. 
 

1. Log in to Simu Connect Desktop Client. 

2. At the top-right corner, click   , then select the connected Fanvil IP phone from the 

drop-down list. 
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Result 

You can do the following operations on the connected Fanvil IP phone from Simu Connect 
Desktop Client: 
 

• Make/End a call 
• Make a second call 
• Answer/Reject a call 
• Record a call 
• Transfer a call (attended transfer and blind transfer) 
• Hold/Resume a call 
• Swap hold 
• Flip a call 

 
 

Control a Snom IP Phone by Simu Connect Desktop 
Client 

By enabling CTI mode on Simu Connect Desktop Client, a Snom IP phone with your 
extension registered can be connected to your Simu Connect Desktop Client. In this way, 
Simu Connect Desktop Client acts as a visual control panel where you can manage phone 
calls, while calls are made and received using the Snom IP phone. 
 

Applications 

This topic is applied to the Snom IP phones that are compatible with Simu Connect 
Desktop Client CTI. 
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Tip: 

For incompatible IP phones, refer to Control an Incompatible IP phone by your 
app name Desktop Client for instructions on phone control. 

 

Requirements 

PBX server 

Contact system administrator to make sure the following requirements are 
met on PBX server: 

 

• The version of PBX server is 84.13.0.25 or later. 

• The uaCSTA feature is enabled (Path: PBX Settings > SIP Settings 
> Advanced > Other Options > Enable uaCSTA Connection). 

 

IP phone 

The extension registered on the IP phone is the same as that of Simu Connect 
Desktop Client. 

 

Note: 

Register only one account on the IP phone, or CTI feature may not 

work. 
 

Step 1. Set the IP phone to be controllable 
 

Note: 

If system administrator has assigned your extension to the IP phone via Auto 
Provisioning, your IP phone is ready for being controlled. In this case, you can 
directly enable CTI mode on Simu Connect Desktop Client. 

 

If system administrator has registered your extension to the IP phone manually, you need to 

set the IP phone to be controllable as follows. 

The following instructions take Snom D735 as an example to show how to enable CSTA 

control function. 
 

1. Log in to the phone web interface, go to Setup > Advanced > QoS/Security. 

2. In the Security section, enable the Allow CSTA Control. 
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3. At the bottom of the page, click Apply. 
 

Step 2. Enable CTI mode on Simu Connect Desktop Client 

Change Simu Connect Desktop Client to CTI mode, so that you can use Simu Connect 
Desktop Client to manage phone calls on your IP phone. 
 

1. Log in to Simu Connect Desktop Client. 

2. At the top-right corner, click   , then select the connected Snom IP phone from the 

drop-down list. 
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Result 

You can do the following operations on the connected Snom IP phone from Simu Connect 
Desktop Client: 
 

• Make/End a call 
• Make a second call 
• Answer/Reject a call 
• Record a call 
• Transfer a call (attended transfer and blind transfer) 
• Hold/Resume a call 
• Swap hold 
• Flip a call 

 
 

Control an Incompatible IP phone by Simu Connect 
Desktop Client 

By enabling CTI mode on Simu Connect Desktop Client, an IP phone with your extension 
registered can be connected to your Simu Connect Desktop Client. In this way, Simu Connect 
Desktop Client acts as a visual control panel whereas calls are made and received using the 
IP phone. 
 

Applications 

This topic is applied to the IP phones that fall out of the range of CTI-compatible devices. 

For CTI-compatible phones, see Compatible Yealink IP phones, Compatible Fanvil IP 
phones, Compatible Snom IP phones, and Compatible Grandstream IP phones. 
 

Procedure 
 

1. Check if the extension registered on the IP phone is the same as that of Simu 
Connect Desktop Client. 

2. Change Simu Connect Desktop Client to CTI mode. 

a. Log in to Simu Connect Desktop Client. 

b. At the top-right corner, click   , then select the connected IP phone from the 

drop-down list. 
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Result 

You can do the following operations on the connected IP phone from Simu Connect 
Desktop Client: 
 

• Make/End a call 

• Reject a call 

• Hold/Resume a call 

• Blind transfer a call 

• Record a call 
 
 

Control Simu Connect Web Client by Simu Connect 
Desktop Client 

By enabling CTI mode on Simu Connect Desktop Client, Simu Connect Web Client with 
your extension logged in can be connected to Simu Connect Desktop Client. In this way, 
Simu Connect Desktop Client acts as a visual control panel where you can manage phone 
calls, while calls are made and received using Simu Connect Web Client. 
 

Scenario 

Imagine that you use a CRM system to manage customer relationships and contact 
customers with click-to-dial via Simu Connect Desktop Client, but the CRM system has 
limited internet access. When you access your work computer from home and click to dial 
in the CRM system, you may experience audio quality issues due to poor network 
conditions. 

In this case, you can log in to Simu Connect Web Client with your extension on your home 
computer, then access your work computer to set Simu Connect Desktop Client to remotely 
control Simu Connect   Web Client via CTI. In doing so, audio streams will be routed through 
Simu Connect Web Client, thus ensuring better audio quality. 
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Requirements 

Make sure that PBX server and your Simu Connect clients meet the following 
requirements: 
 

Item Requirement 

PBX Server • The firmware version is 84.15.0.74 or later. 

• The uaCSTA feature is enabled (Path: PBX Settings > SIP Settings > 
Advanced > Other Options > Enable uaCSTA Connection). 

Simu Connect 
Desktop Client 

Version 1.5.4 or later. 

Simu Connect Web 
Client 

The extension logged in to Simu Connect Web Client is the same as that of 
Simu Connect Desktop Client. 

 

Procedure 
 

1. Log in to Simu Connect Desktop Client. 

2. At the top-right corner, click   , then select Web Client from the drop-down list. 

Screen shoot 

Result 

You can do the following operations on Simu Connect Web Client from Simu Connect 
Desktop Client: 
 

• Make/End a call 
• Make a second call 
• Answer/Reject a call 
• Transfer a call (attended transfer and blind transfer) 
• Record a call 
• Hold/Resume a call 
• Swap hold 
• Add participant 
• Merge calls 
• Flip a call 
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Set up Hotkeys 

Hotkeys (Keyboard Shortcuts) are combinations of keystrokes that allow you to quickly 

perform specific operations without using the mouse. This topic introduces the supported    
shortcut operations, and describes how to enable hotkeys for the operations in Simu 
Connect Desktop Client. 
 

Requirements 
 

• PBX Server: Version 84.12.0.32 or later. 

• Simu Connect Desktop Client: 

◦ Windows Desktop: 1.2.14 or later 

◦ macOS Desktop: 1.2.10 or later 
 

Supported shortcut operations and default hotkeys 

The following table lists the supported shortcut operations and their default hotkeys. The 

hotkeys vary depending on your operating system. 

 

Shortcut Operation Windows Hotkey macOS Hotkey 

Dial Selected Number Ctrl+Shift+E ⌘+Shift+E 

Answer Ctrl+Shift+A ⌘+Shift+A 

Blind Ctrl+Shift+B ⌘+Shift+B 

Attended Ctrl+Shift+T ⌘+Shift+T 

Hold/Resume Ctrl+Shift+H ⌘+Shift+H 

Hang Up Ctrl+Shift+F ⌘+Shift+F 

Send Message Enter Return 

 

Procedure 

By default, all the operations using hotkeys are disabled. You can enable desired 
operations and hotkeys as follows. 
 

1. Access the Settings menu of Simu Connect Desktop Client based on your operating 
system. 
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Operating 
System Instruction 

Windows 
On the system tray, right click   > 
Settings 

 
 
 
 
 
 
 
 
 
 
 
 
 

. 

Screen shoot 

macOS On the App menu, click Simu Connect Desktop Client > Settings. 

Screen shoot 

2. In the Hotkeys section, do as follows: 

a. Optional: To prevent hotkeys from becoming invalid due to hotkey conflicts, 
you can select the checkbox of Notify When Hotkey Conflicts to enable 
notification. 

 

If enabled, each time you launch and log in to Simu Connect Desktop Client, it 
will automatically check for hotkey conflicts. If any, a pop-up window will be 
displayed to prompt the conflict. 
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b. Enable desired shortcut operations and set up hotkeys. 

 

i. Select the checkbox of the desired shortcut operation. 

ii. If you want to change the default hotkey, click the hotkey field on the right, 

then press the desired key combinations on your keyboard. 
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Note: 

The key combinations must begin with Ctrl, ⌘, Shift, or Alt, and 
contain at least one alphabetic or numeric character. 

 

Related information 

Select and Dial with Hotkey 
 

Select and Dial with Hotkey 

Select & Dial with Hotkey feature allows you to quickly dial any phone numbers appear 
on your computer screen. No matter where the phone number is stored, you can simply 
select the number and press the hotkey to quickly dial the phone number via Simu 
Connect Desktop Client. 
 

Requirements 
 

• PBX Server: Version 84.12.0.32 or later. 

• Simu Connect Desktop Client: 

◦ Windows Desktop: 1.2.14 or later 

◦ macOS Desktop: 1.2.10 or later 
 

Step 1. Enable and set up hotkey 

By default, the hotkey for 'Select and Dial with Hotkey' is disabled. You need to enable it on 

Simu Connect Desktop Client. 
 

1. Access the Settings menu of Simu Connect Desktop Client based on your operating 
system. 
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Operating 
System Instruction 

Windows 
On the system tray, right click   > 
Settings 

 
 
 
 
 
 
 
 
 
 
 
 
 

. 

Screen shoot 

macOS On the App menu, click Simu Connect Desktop Client > Settings. 

Screen shoot 

2. In the Hotkeys section, do as follows: 

 

a. Select the checkbox of Dial Selected Number. 

b. If you want to change the default hotkey, click the hotkey field on the right, then 

press the desired key combinations on your keyboard. 
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Step 2. (Optional) Disable dial out immediately 

By default, Simu Connect dials out immediately after you select a number and press the 
hotkeys. If you want to edit the phone number before dialing out, you can disable Dial out 
immediately setting on Simu Connect Desktop Client. 
 

1. Go to Settings page. 

2. In the Call section, unselect the checkbox of Dial out immediately. 

 
 

Example 
 

Example 1: Select & Dial out immediately Example 2: Select & Dial out later 
  

 



 

 
 
 
 

Calls 
 
 

Simu Connect Call Overview 

Simu Connect Desktop Client allows you to connect to colleagues and external contacts via 
audio calls and video calls. This topic describes the requirements for audio call and video 
call, and the supported call features. 
 

Requirements 

Audio call requirements 

For audio call, contact system administrator to ensure that the PBX server's 

configurations are ready: 
 

• Web Server Protocol: HTTPS 

• Codec: Any of u-law, a-law, or G722 is enabled on PBX server. 
 

Video call requirements 

For video call, besides the above requirements, make sure the followings are 

ready on PBX server: 
 

• PBX Plan: Ultimate Plan 

• Codec: Either VP8 or H264 is enabled on PBX server. 
 

Note: 

◦ CodecVP8 is preferred. 

◦ If VP8 and H264 are both enabled, make sure VP8 has the top 
priority. 

 
 

Supported call features 
 

Call Feature Description 

Audio 

Conferencing 

This feature allows you to initiate an instant audio conference during a call. 

 

Note: 

Up to 9 members are supported. 
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Call Feature Description 

 For more information, see Audio Conferencing Overview. 

Call Flip This feature allows you to flip an active call from Simu Connect Desktop Client to 
another device (with your extension registered), without any interruption to the 
conversation. 

For more information, see Flip an Active Call between Devices. 

Call Switch This feature allows you to retrieve an active call from the original device (with   
your extension registered) to Simu Connect Desktop Client, without any 
interruption to the conversation. 

For more information, see Continue an Active Call on Simu Connect Desktop 
Client. 

Call Transfer This feature allows you to transfer an ongoing call to another number. 
For more information, see Transfer a call. 

Call Merge This feature allows you to merge two or more active calls into an audio 
conference call. 

For more information, see Merge Calls into an Audio Conference Call. 

Call Hold/Resume This feature allows you to pause your conversation without having to hang up, 
and resume the call when you are ready. 

 

Note: 

Allow to hold up to 6 active calls at the same time. 

For more information, see Hold and Resume a Call. 

Call Recording This feature allows you to record calls and playback later to review and confirm 
information. 

For more information, see Record a Call. 

Call Note This feature allows you to add tags and remarks for calls, capturing essential 
information for future reference. 

For more information, see Add Notes to a Call. 

 

Flip an Active Call between Devices 

Call Flip feature allows you to effortlessly and seamlessly flip an active call from your app 
name Desktop Client to another device (with your extension registered), without any 
interruption to the conversation. 
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Scenario 

Assume that you are in a call with a customer, but have to get out of the office. In this 
case, you can flip the call to your mobile phone, keeping talking without customer knowing 
the switchover. 
 

 
 
 

Requirements 

Your extension has been registered on more than one device. 
 

Procedure 
 

1. During an active call, click Call Flip. 

All the other devices where your extension is registered are displayed. 
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2. Click the desired device. 

Simu Connect will make a call to your extension on the device. 
 

Tip: 

In case you want to cancel call flip, click Cancel at the bottom-right corner of 
the call screen. 

 
 

3. Answer the call on the selected device. 
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The call is flipped from Simu Connect Desktop Client to the selected device. 
 

Related information 

Continue an Active Call on Simu Connect Desktop Client 
 
 

Continue an Active Call on Simu Connect Desktop 
Client 

Call Switch feature allows you to retrieve an active call from the original device (with your 

extension registered) to Simu Connect Desktop Client, without any interruption to the 
conversation. 
 

Scenario 

Assume that you answer a call from a customer while on the road, and you want to be     
hands-free when returning to the office. In this case, you can retrieve the active call 
from mobile phone to Simu Connect Desktop Client, keeping talking without customer 
knowing the switchover. 
 

 
 

Requirements 
 

• Simu Connect Desktop Client: In Desktop Client mode. 
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• Extension: Your extension has been registered on more than one device. 
 

Prerequisites 

You have an active call on another device. 
 

Procedure 

Screen shoot 
 

1. On the top of Simu Connect Desktop Client, click Call Switch. 

The active call on another device is displayed. 

2. Click the call. 
 

Result 

The call is retrieved from the original device to Simu Connect Desktop Client. 

Related information 

Flip an Active Call between Devices 
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Transfer a call 

Call Transfer feature allows you to transfer an ongoing call to another number. For example, 
if you receive a call from a customer who reaches the wrong person or team, you can transfer 
the call to the correct one rather than asking the customer to hang up and call a different 
number. 

Types of Call Transfer 

There are two types of call transfer: 
 

• Blind Transfer: Transfer an ongoing call to a third party immediately without giving 
him or her prior notification. 

For more information, see Perform a blind transfer. 

• Attended Transfer: Put the ongoing call on hold and establish a second call with 

third party to pass on all relevant information and get his or her consent before 
transferring the call. 

For more information, see Perform an attended transfer. 
 

Perform a blind transfer 
 

1. During an active call, click  (Transfer) on the call screen, then select Blind 
Transfer. 
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The call is put on hold. 

2. Select the desired individual using either of the following methods. 

• In the right-panel, select a list and click on the desired extension user or 
contact who you want to transfer the call to. 

 

• In the search bar, enter the number or the name of the extension user or contact 
who you want to transfer the call to, then select the desired number from the 
result. 
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The current call is disconnected; The specified extension user or contact will receive 

the call. When the call is answered, the other two parties are connected. 
 

Perform an attended transfer 
 

1. During an active call, click   (Transfer) on the call screen, then select Attended 
Transfer. 
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The call is put on hold. 

2. Select the desired individual using either of the following methods. 

• In the right-panel, select a list and click on the desired extension user or 
contact who you want to transfer the call to. 

 

• In the search bar, enter the number or the name of the extension user or contact 
who you want to transfer the call to, then select the desired number from the 
result. 
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The specified extension user or contact will receive a call. 

3. If the specified contact answers the call, you can talk to the contact to pass on all rele- 

vant information first, then click Transfer. 

 

The current call is disconnected; The other two parties are connected. 
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Related information 

VoIP Features for Dummies - Call Transfer 
 

Merge Calls into an Audio Conference Call 

When there are two active calls or more on Simu Connect Desktop Client, you can merge 
them into a 3-way audio conference call, and host and manage it as the conference host. 
 

Requirements and restrictions 

Requirements 

Make sure that the version of Simu Connect Desktop Client meets the following 
requirements: 

 

• Windows Desktop: Version 1.7.3 or later 

• Mac Desktop: Version 1.7.3 or later 
 

Restrictions 

Only calls of the same type (either both voice calls or both video calls) can be 

merged into an audio conference call. 
 

Prerequisites 
 

• Make sure that Simu Connect Desktop Client is in Desktop Client mode. 

 
 

• You have two active calls or more of the same type on Simu Connect Desktop Client. 

https://www.youtube.com/watch?v=nExe2eSbT0I
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Procedure 
 

1. At the bottom of the call panel, click Merge Calls. 

2. Perform the following operation to merge calls. 

• If there are two active calls, click Confirm in the pop-up window. 
• If there are more than two active calls, select the call that you want to 

merge, then click Confirm. 
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Result 

The active calls are merged into 3-way audio conference call, and you are the host. 

 

Related information 

Audio Conference Call Operations 
 
 

Hold and Resume a Call 

Call Hold and Resume feature allows you to pause your conversation without having to 

hang up, and resume the call when you are ready. 
 

Procedure 
 

1. To put a call on hold, click    (Hold) on the call screen during an active call. 
 

Note: 

Allow to hold up to 6 active calls at the same time. 
 

The held party cannot communicate with you; The held party may hear a piece of 
music, depending on system administrator's configuration. 

2. To resume the call, click    (Hold) again. 
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You can communicate with each other now. 
 
 

Record a Call 

Call Recording feature allows you to record calls and play back later to review and confirm 

information. 
 

Requirements 

System administrator has granted you the permission to record calls. 
 

Procedure 

During an active call, click   (Record) on the call screen. 
 

Result 
 

• The call is being recorded. 

• Both sides may hear a voice prompt announcing that the call is now being 
recorded, this depends on system administrator's configuration. 

 
 

Select Outbound Caller ID (DOD) to Call 

Before making outbound calls from your app name, you can select which outbound caller 
ID (DOD) to display. You can use the same DOD number for all outbound calls or select a 
specific DOD for each call. 
 

Requirements 
 

• PBX Server: Version 84.16.0.25 or later 

• Simu Connect Desktop Client: Version 1.6.0 or later 

• Extension: Your extension has been assigned the permission to select outbound 
caller IDs. 

 

Customize DOD display 

You can add a short description or adjust the order of the DODs assigned to your extension, 

which determines how the DODs will be displayed on your Simu Connect UC Clients. 
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1. Log in to Simu Connect Desktop Client, go to Preferences > User > Outbound 
Caller ID (DOD). 

All the selectable DODs are displayed on the list. 

2. Customize DOD display as needed. 

 

• Label: Enter a short description, which is used to label the DOD number. 

For example, if you enter New York Office for DOD 2345068, the DOD will ap- 
pear as 2345068 (New York Office) on your Simu Connect UC Clients. 

• Move: Click  不     v   业   to adjust the order in which the DODs are displayed 

on your Simu Connect UC Clients. 

3. Click Save. 
 

Methods of selecting DOD to call 

By default, the DOD number configured by system administrator is used when you make     
outbound calls. You can choose to use the same DOD number for all outbound calls or 
select a specific DOD for each call. 
 

• Use the same DOD for all outbound calls: At the top-right corner, select a desired 
DOD number from the drop-down list beside Dial pad. 
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Every time you make an outbound call using Dial pad, the DOD number will be used. 

• Select a specific DOD for each call: Select a desired DOD number before you 
make an outbound call. 

You can select a specific DOD number from the drop-down list beside Dial pad, or 
from the Contacts, Call Logs, Voicemails, or Recordings page, as shown below. 

 

Page Instruction 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 

6. Call Logs, 

Voicemails, or 
Recordings 

1. Go to Call Logs /Voicemails / Recordings. 
2. Right click a desired record. 

3. Click Select DOD to Call, then select a specific DOD 
number. 

 

 

Figure 5. 

Contacts 

 

 

1. Go to Contacts and find the desired contact. 

2. Click . . .  > Select DOD to Call, then select a specific DOD 

number. 
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Add Notes to a Call 

Call Note feature allows you to take notes directly during calls, and to review or edit notes 
in call logs after calls, helping you to capture important details for future reference. 
 

Requirements 

PBX Server 

• The firmware of the PBX server is version 84.18.0.102 or later 

• System administrator has configured call disposition codes on server, and 
granted you the permission to use call note feature. 

 

Simu Connect Desktop Client 

• Make sure that the version of Simu Connect Desktop Client is version 
1.11.7 or later. 

 

Procedure 
 

1. During an active call, click Call Notes to open the call note panel. 
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2. In the side panel, add tags and remarks for the call according to your needs. 

 

a. In the Select Call Disposition drop-down list, select a disposition code. 

b. In the Remark field, enter short descriptions to note down essential information 
for the call. 

c. Click Save. 
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Result 
 

• An "Edited Successfully" prompt pops up, indicating that call note is saved 
successfully. 

 

Note: 

You can modify and save the notes multiple times before the call ends. 

• If the call is transferred, the next user with access to the call note feature can view 
the last call note after answering the call. 

 

• After calls, you can review or edit the call notes you added in the corresponding 
call log (Path: Call Logs). 

 



 

 
 
 
 

Audio Conferencing 
 
 

Audio Conferencing Overview 

Audio Conferencing is a feature that aims for instant meeting while on a call. If third party 
involvement is needed during a call, you can invite them to an audio conference by directly 
dialing their phone numbers. 
 

Restrictions 

Up to 9 members can be on an audio conference call. 
 

Highlights 
 

 Instant conference calls 

Initiate an instant audio conference during a 
call, without the need for leaving the current 
conversation or being back in the office. 

Flexibly invite members 

Invite any members you want to the audio 

conference, this can be colleagues or external 
business partners. 

Easily control meeting 

Meeting control is at your fingertips. Operations 
such as mute/unmute, members add/delete, 
and recording enable/disable are only one-click 
away. 

 

Invite Participants to an Audio Conference Call 

If third party involvement is needed while on a call, you can send the invitation by directly 

dialing them. As soon as the invitation is sent out, the call would turn into an audio 
conference call. 
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Prerequisites 

Make sure Simu Connect Desktop Client is in Desktop Client mode, or you can NOT 
invite participants to an audio conference call. 
 

Procedure 
 

1. During an active call, click Add Participant at the bottom-left corner of the call 
screen. 

2. On the right panel, invite participants using either of the following methods. 

• Select a list and click on the desired extension user or contact. 

 

• To directly search specific individuals, do as follow: 
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a. In the search bar, search extension users or native contacts by the sup- 

ported filters, or directly invite external users by entering a phone number. 
 

Invitee Supported Filters 

Extension Users 。Extension Name 

。Extension 

Number 。Email 

Address 

。Mobile Number 

Native Contacts 。Contact Name 

。Company 

Name 。Email 

Address 

。Mobile Number 

External Users 。External Number 

b. Click on the desired individual in the search results. 
 

Result 
 

• The phone call turns into an audio conference call, where you can see a call is 
sending to the invitee without interrupting the current conversation. 

 

Note: 

。If the invitee is an extension user that has set up call forwarding 

rules, Simu Connect will still keep ringing the user until timeout. 
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。In case you want to cancel invitation, click 

 

under the desired invitee. 

 

 

• The one who sends the call invitation first will be the conference "Host". The Host can 
manage the audio conference. For more information, see Control an In-progress Audio 

Conference. 

 
 
 

Audio Conference Call Operations 

This topic describes what operations a host and a participant can do in an audio conference 

call. 
 

Operations 

Refer to the following table to check the available operations for a host and a participant in 

an audio conference call. 
 

Operation Host Participant 

Turn on/Turn off one's own audio √ √ 

Turn on/Turn off participants’ audio √ × 
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Operation Host Participant 

Record a conference √ 
× 

End a conference √ 
× 

Leave a conference √ √ 

*View participants list √ √ 

*Invite participants √ √ 

Remove participants √ 
× 

 

Note: 

Operations marked with * only work for Simu Connect Desktop Client users, 
Simu Connect Web Client users, and 'Cloud One Simu Connect for Google' 
users. 
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Control an In-progress Audio Conference 
 

Preview of an in-progress audio conference 
 

 
 

Shortcuts for common actions 
 

 Get call window zoomed out.  
 
Full screen mode. 

 
Main content area 

Display audio feed of all the participants. 

If you are the host, you can manage participants as follows: 



 

Simu Connect Desktop Client User Guide | 10 - Audio Conferencing | 115 

 
 

• Click  to mute or unmute a specific participant. 
 

Tip: 

The microphone status can be synchronized on the call screen of the 
following: 

◦ Simu Connect Mobile Client 

◦ Simu Connect Desktop Client 

◦ Simu Connect Web Client 

◦ Cloud One Simu Connect for Google 
 

• Click  to remove an existing participant from the audio conference, or to cancel 
inviting a new participant. 

 

Toolbar 

New Call 

Place another call while you are on the audio conference call. 
 

Note: 

You can be on two calls at most. If you make or receive another call, 

the audio conference call will be automatically held. 
 

Add Participant 

Add participants to the audio conference call. 

Mute 

Mute or unmute yourself. 

Hold/Resume 

Hold or resume yourself. 

Dialpad 

Press a key to send DTMF signal. 

Record 

Control recording for the conference call. 
 

 
      Note: 
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• Only the authorized conference host can control the recording 
during the conference call, as well as view and manage the recording 
file generated after the conference call ended. 
• If conference host exits an audio conference call that is being 

recorded, the recording would stop. 
 
 
 

End Call 

End or leave the conference call. 
 

Note: 

Only the conference host can end the conference call. 
 
 
 

Exit or End an Audio Conference 

This topic describes how to exit or end an audio conference. 
 

Exit an audio conference 

You can exit the audio conference if you need to leave early due to unforeseen 
circumstances. 

Procedure 

1. If you are the host, you can exit the audio conference as follows: 

a. On the bottom toolbar, click End Call. 

b. Select Leave Conference and click Confirm. 

You exit the conference call; The audio conference is still in 

progress without a host, and none of the participants can invite 
others to join the conference. 

 

Note: 

If you have enabled recording for the audio conference, 

the recording stops as soon as you leave the conference. 

 

2. If you are NOT the host, you can directly hang up the conference call. 
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End an audio conference 

Only the conference host can end the audio conference. 

Procedure 
 

1. On the bottom toolbar, click End Call. 

2. Select End Conference and click Confirm. 
 

Result 

The conference is ended from all the participants' sides and your side. 



 

 
 
 
 

Call Logs 
 
 

Check and Manage Call Logs 

This topic describes how to view the calls that you made, answered, or missed, and how 
to manage the personal call logs on Simu Connect Desktop Client. 
 

Procedure 
 

1. On Simu Connect Desktop Client, go to Call Logs. 

2. Optional: Select a communication type from the drop-down list of  to filter call 

logs. 

 

3. Optional: Search or filter specific call logs by name, number, time range, disposition 
codes, or remark. 

 

4. Manage the call logs according to your needs. 
 

Operation Instruction 

Check or edit call 
notes 

You can check or edit call notes you've added for a call. 
• To check the call note, hover your mouse over the tag(s). 
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Instruction 

  
 
 
 
 

• To edit the call note, do as follows: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

a. Hover your mouse over the call log, then click       . 

b. In the pop-up window, edit the call note as needed, then click 
Save. 

Place a call You can directly place a call from a call log via the following methods: 
• Double click the desired call log. 

• Hover your mouse over the call log, then click       . 

Delete a 
personal call 
log 

To delete a call log, do as follows: 

 
 
 
 
 
 
 
 
 

a. Hover your mouse over the desired call log, then click       . 

 

Operation 
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Operation Instruction 

 b. In the pop-up window, click OK. 

The personal call log is removed from Simu Connect UC Clients. 

Clear all personal 
call logs 

To delete all your personal call logs, do as follows: 

 
 
 
 
 
 
 
 
 

a. Click         on the top-right corner. 

b. In the pop-up window, click OK. 

All your personal call logs are removed from Simu Connect UC 
Clients. 

Related information 

Manage Queue Call Logs 

https://help.yeastar.com/en/p-series-cloud-edition/contact-center-guide/manage-queue-call-logs-desktop.html


 

 
 
 
 

Voicemails 
 
 

Check and Manage Voicemails 

This topic describes how to check and manage your voicemails on Simu Connect Desktop 
Client. 
 

Note: 

Changes made to voicemails on Simu Connect Desktop Client will be synchronized 
to Simu Connect Web Client and Simu Connect Mobile Client. 

 

Procedure 
 

1. On Simu Connect Desktop Client, go to Voicemails. 

2. Optional: Select specific read status to filter voicemails. 

 

3. Check and manage the voicemails according to your needs: 
 

Operation Instruction 

Listen to a voicemail a. Hover your mouse over the desired record. 

b. At the right side, click  . 

An unread voicemail will be marked as read. 

View a transcribed 
voicemail text Note: 

This operation is available only if system administrator has 
set up voicemail transcription feature. 

a. Hover your mouse over the desired record. 

b. At the right side, click  
 

. 

Place a call You can directly place a call from a voicemail record via the 
following methods: 

 



 

Simu Connect Desktop Client User Guide | 12 - Voicemails | 122 

 

 

Operation Instruction 

 • Double click the desired record. 

• Hover your mouse over the desired record, and click   . 

Download a voicemail a. Hover your mouse over the desired record. 

b. At the right side, click  . 

Change the read status • To mark a voicemail as read or unread, do as follows: 

a. Right click on the desired record. 

b. Click Mark as Read or Mark as unread. 
• To bulk mark voicemails as read, do as follows: 

a. Select the checkboxes of the desired records. 

b. At the top menu, click Mark as Read. 

Delete voicemail(s) • To delete a voicemail, do as follows: 

a. Hover your mouse over the desired record. 

b. At the right side, click  . 

c. In the pop-up window, click OK. 
• To bulk delete voicemails, do as follows: 

a. Select the checkboxes of the desired voicemails. 

b. At the top menu, click Delete. 

c. In the pop-up window, click OK. 

 



 

 
 
 
 

Recordings 
 
 

Check and Manage Recordings 

This topic describes how to check and manage your call recordings on Simu Connect 
Desktop Client. 
 

Note: 

Changes made to recordings on Simu Connect Desktop Client will be synchronized 
to Simu Connect Web Client and Simu Connect Mobile Client. 

 

Requirements 

System administrator has granted you the permission to view recordings. 
 

Procedure 
 

1. On Simu Connect Desktop Client, go to Recordings. 
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Screen shoot 

2. Check and manage the call recordings according to your needs. 
 

Instruction 

Listen to a call 
recording 

a. Hover your mouse over the desired record. 

b. At the right side, click  . 

Place an audio call You can directly place an audio call from a call recording record via the 
following methods: 

• Double click the desired record. 

• Hover your mouse over the desired record, then click   . 

 

Operation 
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Instruction 

  

a. Hover your mouse over the desired record. 

b. At the right side, click  . 

Delete call 
recording(s) 

• To delete a call recording, do as follows: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

a. Hover your mouse over the desired record. 

b. At the right side, click  . 

c. In the pop-up window, click OK. 
• To bulk delete call recordings, do as follows: 

 

 
Download a call  

recording 

 

Operation 
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Operation Instruction 

  
 
 
 
 
 
 
 
 
 
 
 

a. Select the checkboxes of the desired call 
recordings. 

b. At the top menu, click Delete. 

c. In the pop-up window, click OK. 

 



 

 
 
 

Upgrade 
 
 

Upgrade Simu Connect Desktop Client 

When a new version is released, Simu Connect Desktop Client will show a pop-up 
window, where you can find out what's new in the latest version. You can upgrade to the 
new version immediately or later. If you choose to upgrade later, follow the instructions in 
this topic to upgrade Simu Connect Desktop Client anytime you want. 
 

1. Access the menu of Simu Connect Desktop Client based on your operating system. 

• For Windows: On the system tray, right click  . 

Screen shoot 

• For macOS: On the App menu, click Simu Connect Desktop Client. 

Screen shoot 

2. Select About from the menu. 

3. In the pop-up window, click Check for updates. 

A window pops up to show you what's new in the latest version. 
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Screen shoot 

4. Click Update Now. 

The new installation package is downloaded. 

5. Install the installation package. 

When the installation is completed, Simu Connect Desktop Client is upgraded 
successfully. 



 

 
 
 
 

Bug Reporting 
 
 

Report Simu Connect Problems 

If you encounter problems with your Simu Connect Desktop Client, you can download 
Simu Connect debug logs and send the logs to Cloud One support for analysis. 
 

1. Download Simu Connect debug logs. 

a. Access the menu of Simu Connect Desktop Client based on your operating 
system. 

• For Windows: On the system tray, right click  . 

Screen shoot 

• For macOS: On the App menu, click Simu Connect Desktop Client. 

Screen shoot 

b. Select Download Logs from the menu, then save the log file to your computer. 

2. Submit a ticket to report the problem to Cloud One Support, and provide the debug 
logs. 

mailto:support@cloudone.co


 

 
 
 
 

Extension Preferences 
 
 

User 
 

Update Your Extension Profile 

This topic describes how to upload profile image and configure account information. 
 

Procedure 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > User > User 
Information. 

2. Click  to upload your profile image. 
 

Note: 

The image must be  .jpg or  .png, and can not exceed 1MB. 

3. Configure your account information as needed. 

• First Name 

• Last Name 

• Email Address: You can receive voicemail messages and notifications 
for missed calls and password changes via the email address. 

• Mobile Number: You can receive calls via this mobile number. 

• System Prompt Language: Select the language of system prompts to be 
played to you during a call. 

4. Click Save. 
 

View Outbound Caller ID 

Outbound Caller ID is the number and name that displayed on the callees' phone when you 
make outbound calls via specific trunks. This topic describes how to view Outbound Caller 
ID. 
 

Scenario 

You are a technical support, and use the trunk "Outbound_US" to contact your cus- 

tomers. Your system administrator can set up a specific Outbound Caller ID Number (eg. 

0592-5503301) and a specific Outbound Caller ID Name (eg. Cloud One Support) for this 
trunk. 
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In this way, when you contact your customers via the trunk "Outbound_US", the callees' 

phone will display "Cloud One Support <0592-5503301>", so that they can verify the 
identity of the caller. 
 

Procedure 
 

1. Log in to Simu Connect Desktop Client. 

2. Go to Preferences > User > Outbound Caller ID (DOD) > Outbound Caller IDs. 
 

Result 

The Outbound Caller IDs list displays the Outbound Caller ID Number, Outbound Caller 
ID Name, and associated trunk that system administrator has configured for you. 

 
 

View Emergency Outbound Caller ID 

This topic describes how to view Emergency Outbound Caller ID. 
 

Background information 

Your company has purchased enhanced emergency service, and system administrator has 

associated your office extension with an exclusive Emergency Location Identification 
Number (ELIN, which is associated with your office location). When you place an 
emergency call by the extension, the emergency operator terminal will display your location. 
 

Note: 

You extension associated with ELIN should be registered on a corded IP desk 

phone. 
 

Procedure 
 

1. Log in to Simu Connect Desktop Client. 
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2. Go to Preferences > User > Outbound Caller ID (DOD) > Emergency Outbound 
Caller ID. 

 
 

Result 

When you place an emergency call, the Public Safety Answering Point (PSAP) will 
pinpoint your location via ELIN, and arrange appropriate emergency response. 
 
 

Presence 
 

Configure Presence Settings 

Simu Connect provides different presence statuses to let your colleagues know if you are 
currently available. This topic introduces the types of presence statuses and the presence 
settings. Simu Connect provides the following presence statuses. 
 

•  Available 

•  Away 

•  Business Trip 

•  Do Not Disturb 

•  Lunch Break 

• e Off Work 

You can go to Preferences > Presence, select a presence status and configure the 
following settings differently. When your presence status changes, the presence settings 
will change accordingly. 
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Presence Information 
 

Setting Description 

Presence Information Add a note to the current presence. 

 

Call Forwarding 

Call forwarding rules help you forward incoming calls to a specific destination when you are 

unavailable. 
 

Setting Description 

Types of incoming calls Select a call type. 

• Internal Calls: Set a call forwarding rule for incoming calls 
from your colleagues. 

• External Calls: Set a call forwarding rule for incoming calls 
from external users. 

Forwarding condition Turn on the switch of a forwarding condition, then configure a 
destination. 

  Note: 
Do Not Disturb presence only supports the optionAlways. 

• Always: Forward all incoming calls to the designated 
destination. 

• No Answer: Only forward unanswered calls to the 
designated destination. 

• When Busy: Only forward the calls that come in while you 
are talking on the phone to the designated destination. 

 

Ring Strategy 

Ring strategy allows you to decide in which order incoming calls are distributed to the end- 

points where your extension is registered. 
 

Note: 

Do Not Disturb presence does not support this setting. 
 

• Extension Endpoint: The IP phone, analog phone, or softphone where your 
extension is registered. 

• Simu Connect Mobile Client 
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• Simu Connect Desktop Client (Softphone only) 

• Simu Connect Web Client (Web Client Mode only) 

 

Setting Description 

Ring First Set which endpoint(s) will ring first when a call reaches your 
extension. 

Ring Secondly Set which endpoint(s) will ring if the incoming call is not answered on 
the endpoints that are selected as Ring First. 

 

Ring Timeout 

To prevent callers from waiting for a long time, you can configure ring timeout. If a call is 
not answered during the time period, it will be routed to the destination of No Answer. 
 

Note: 

Do Not Disturb presence does not support this setting. 

 

Setting Description 

Ring Timeout(s) Set the timeout period. 

 

Note: 

The valid range is from 5 to 300 
seconds. 

 

Ring the Mobile Number Simultaneously 

To simultaneously ring both extension and the associated mobile number when anyone 

calls in your extension number, you can configure a simultaneous ring strategy. 
 

Note: 

Do Not Disturb presence does not support this setting. 

 

Setting  Description 

Ring Mobile Number Simultaneously  Check the option to enable this feature. 

  

 

  Tip: 

Click  to configure your mobile number. 
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Setting  Description 

Prefix  
 

Enter the prefix of outbound route so that PBX server can 
successfully send calls out. 

 

Note: 

Contact system administrator to check if a prefix is 
required. 

 

Accept Push Notifications 

By default, you can receive push notifications on Simu Connect Mobile Client anywhere and 
anytime, such as missed calls, new voicemail messages and so on. If you don't want to 
receive notifications after work, you can disable the feature. 
 

Setting Description 

Accept Push Notifications Enable or disable push notifications on Simu Connect Mobile 
Client. 

 

Accept calls from Ring Group 

By default, you can receive ring group calls under any presence. You can set whether to 
receive ring group calls under the specific presence as needed. 
 

Setting Description 

Accept calls from Ring Group Enable or disable receive ring group calls under the this 
presence. 

 

Agent Status Auto Switch 

If you are a dynamic agent who needs to frequently log in to or out of a queue, you can  

associate your queue status with your extension presence. Your status in a queue will 
automatically change along with your extension presence. 
 

Setting  Description 

Log In  Log in to a queue. 

  

Log Out Log out of a queue. 

Pause Pause receiving queue calls, and select a specific pause 
reason as needed. 

 

  Note: 

The option is available ONLY in Available status. 
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Setting Description 

Do Nothing Retain current status. 

Related information 

Manually Switch Presence Status 

Automatically Switch Presence Status Based on Business Hours and Holidays 
 

Manually Switch Presence Status 

This topic describes how to manually switch your current presence status to a new one, including 
fixed status and temporary status. 
 

Switch presence status to a fixed status 
 

1. Log in to Simu Connect Desktop Client. 

2. In the top pane, select a presence status from the drop-down list of presence. 

 
 

The presence status and the relevant presence settings take effect. 
 

Switch presence status to a temporary status 

Assume that you would be away for a scheduled meeting during which you are unavailable   
to answer calls, but you want calls to be forwarded to the previous destination when you are 
available. In case you forget to change presence status, you can switch presence to a 
temporary status, and set how long the status will last. 
 

1. Log in to Simu Connect Desktop Client. 

2. In the top pane, select Set Temporary Status from the drop-down list of presence. 
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3. In the pop-up window, configure the following settings: 

a. In the Change Status To drop-down list, select a temporary status. 

b. In the Hour and Minute drop-down list, set how long the temporary status will 
last. 

c. Optional: In the Set Status Message field, add a note to the temporary status. 

4. Click Save. 

The presence status and the relevant presence settings take effect. 
 

Tip: 

In the top pane, you can hover your mouse over the presence to check when 

will the temporary status ends. When the time is up, presence status and relevant 
settings would be switched back to the previous one. 

 

Related information 

Automatically Switch Presence Status Based on Business Hours and Holidays 

Automatically Switch Presence Status Based on Business Hours 

and Holidays 

You can configure different presence status based on business hours and holidays. In 
this way, the extension presence will automatically switch to the preset status based on 
the 

time. 
 

Requirement 

System administrator has set up business hours and holidays. 
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Procedure 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Features. 

2. In the Time-conditional Presence Auto Switch section, specify a presence status 
to be displayed for the desired time. 

 
 

3. Click Save. 
 

Result 

Presence status will be switched automatically according to the business hours and 
holidays. 

For example, the system administrator has set the Break Hours as 12:00-14:00, and you 
have selected Lunch Break for Break Hours. Then Simu Connect will automatically 
switch your presence status to Lunch Break during 12:00-14:00. 

Related information 

Manually Switch Presence Status 
 
 

Voicemail 
 
 

Customize Your Voicemail Settings 

This topic describes how to customize your voicemail settings, including voicemail access 

PIN, new voicemail notification, voicemail play options, and voicemail greetings. 
 

Procedure 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Voicemail. 

2. Turn on the option Enable Voicemail. 
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3. In the Voicemail PIN Authentication drop-down list, decide whether a PIN is re- 

quired when you access voicemail. 

• Enabled: You need to enter a PIN to access your voicemail 
messages. You can set the PIN number in the Voicemail Access PIN 
field. 

• Disabled: You can access your voicemail messages directly. 

4. In the Voicemail Language drop-down list, select the language of the system 

prompts heard by caller when they access your voicemailbox. 

When callers are routed to your extension's voicemail, the system prompt "The 
extension  {extension_number} you dialed cannot be connected now. Please leave 
your message after the tone. When done, hang up, or press the # key" will be played 
in the selected language. 

 

Note: 

If you set up a voicemail greeting, the custom greeting will be played to 

callers instead. 

5. In the New Voicemail Notification drop-down list, decide whether to receive email 
notification for new voicemails. 

• To disable email notifications, select Do Not Send Email Notifications. 

• To enable email notifications, select one of the following options: 

◦ Send Email Notifications with Attachment: Send a notification email 
with the new voicemail message attached as a  .wav file. 

◦ Send Email Notifications without Attachment: Send notification 
emails only. 

6. If you enabled email notifications, configure the following settings as needed: 
 

Setting Description 

After Notification Decide how to deal with voicemails after notification emails are sent 
out. 

• Mark as Read: Mark the voicemail message in mailbox as 
read. 

• Delete Voicemail: Delete the voicemail messages from 
mailbox. 

• Do Nothing: Keep the voicemail message in mailbox as 
unread. 

Send to Specify the email address for receiving notification emails. 

• User Email: Send notification emails to your email address. • 
Custom Email: Send notification emails to a custom email   
 address. 
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Setting Description 

 Enter the desired email address in the Custom Email 
Address field. 

7. Optional: Set whether to play the following messages when playing a voicemail. 

• Play Date and Time: Enable this option to play date and time when the 
message is received. 

◦ Time Display Format: If Play Date and Time is enabled, you can 
specify the time format (12-hour or 24-hour) for announcing the 
message arrival time. 

• Play Caller ID: Enable this option to play caller ID information. 

• Play Message Duration: Enable this option to play duration of the message. 

8. In the Voicemail Greeting section, decide which greeting will be played to callers 

when they reach your mailbox. 

By default, the system greeting is your default greeting, you can upload or record 
custom voicemail greetings and set it as the new default greeting. 

 
 
 

Note: 

If you want to play specific greetings based on your presence status, select 

an existing one from the corresponding drop-down list. 
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9. Click Save. 
 

Upload or Record Voicemail Greetings 

Voicemail greetings are played to callers when they reach your mailbox. This topic de- 

scribes how to upload or record your personal voicemail greetings. 
 

Restrictions 

Up to 10 custom voicemail greetings are supported. 
 

Upload a voicemail greeting 

Prerequisites 

Prepare an audio file, which must meet the following requirements: 
 

• File format:  .wav,  .mp3, or  .gsm 

◦ PCM, 8K, 16bit, 128kbps 

◦ A-law(g.711), 8k, 8bit, 64kbps 

◦ u-law(g.711), 8k, 8bit, 64kbps 

• File size: Up to 8 MB 
 

Procedure 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Voicemail. 

2. In the Voicemail Greeting section, click Greeting Management. 
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3. In the pop-up window, click Upload. 

4. Select an audio file to upload. 
 

Result 
 

• The uploaded greeting is displayed in the Greeting Management tab. 
• You can set this greeting as the default greeting or the presence 
greeting by selecting it from the corresponding drop-down list. 

 

Figure 7. Set as the 
default greeting 

Figure 8. Set as the 
presence greeting 

 

 

Record a voicemail greeting 

Procedure 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Voicemail. 

2. In the Voicemail Greeting section, click Greeting Management. 
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3. In the pop-up window, click Record New Greeting tab, and configure the 
following settings: 

a. In the Audio File Name field, enter a name to help you identify it. 

b. In the Extension drop-down list, select your extension to record a 

greeting. 

c. Click Confirm. 

The system places a call to your extension. 

4. Answer the call, then record your greeting, and hang up after you finish 

recording. 
 

Result 
 

• The recorded greeting is displayed in the Greeting Management tab. 
• You can set this greeting as the default greeting or the presence 
greeting by selecting it from the corresponding drop-down list. 

 
 

 

Manage Personal Voicemail Greetings 

This topic describes how to manage your voicemail greeting, including playing, downloading, 
and deleting greetings. 
 

Play a voicemail greeting 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Voicemail. 

2. In the Voicemail Greeting section, click Greeting Management. 

Figure 9. Set as the default greeting 
 

 

Figure 10. Set as the presence 
greeting 
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3. Select the greeting that you want to play, click   . 

4. In the pop-up window, choose how to play the greeting: 

• Play on Web: Click  to play the greeting on the Simu Connect Desktop 
Client directly. 

• Play to Extension: Play the greeting on your phone.  

a. Select your extension, and click Play. 

The system places a call to your extension. 

b. Pick up the call to listen to the greeting on the phone. 
 

Download a voicemail greeting 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Voicemail. 

2. In the Voicemail Greeting section, click Greeting Management. 

3. Select the greeting that you want to download, click  . 
 

Delete voicemail greetings 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Voicemail. 

2. In the Voicemail Greeting section, click Greeting Management. 

3. Delete one or more greetings according to your needs. 

• To delete a greeting, click  beside the greeting and click OK. 

• To delete greetings in bulk, select the desired greetings and click Delete, 
then click OK. 

 

Audio and Video 
 

Configure Audio and Video Devices 

This topic describes how to select the desired audio device and video device for your Simu 
Connect Desktop Client. 
 

Prerequisites 

Simu Connect Desktop Client is in Desktop Client mode. 
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Procedure 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Audio &Video. 

2. In the Multimedia Device section, select desired device from the drop-down list of 
Camera, Microphone, Speaker, and Ringing Device. 

 

Important: 

Video device requires the subscription to Ultimate Plan (UP) of your  

organization's server. 
 
 

 

3. If you have a headset compatible with Simu Connect Desktop Client, you can set up 
the head- set to work with Simu Connect Desktop Client in the Headset Integration 
section. In this way, you can control Simu Connect calls directly from the headset. 

For the compatible headsets and the integration instructions, see Integrate HID-
compliant Headsets with Simu Connect Desktop Client. 

4. Click Save. 
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Integrate HID-compliant Headsets with Simu Connect Desktop 
Client 

If you have a HID-compliant headset on hand, you can set up the HID-compliant headset 
as the audio device for Simu Connect Desktop Client, so as to control Simu Connect calls 
via the headset. 
 

Supported headset types 

All HID-compatible headsets (connected via USB or Bluetooth transmitter) are supported. 
 

Note: 

Headsets from Jabra, Yealink, EPOS, Poly have been verified to work properly. 

Headsets from other brands may be subject to limitations. 
 

Procedure 
 

1. Make sure that Simu Connect Desktop Client is in Desktop Client mode, or you can 
NOT set up the HID-compliant headset as the audio device. 

a. Log in to Simu Connect Desktop Client. 

b. At the toolbar, check if   is displayed. 

 

If not, select Desktop Client from the drop-down list. 

2. Connect the HID-compliant headset to the USB port of your computer. 

3. Go to Preferences > Audio &Video > Headset Integration, set the headset as the 
audio device. 

a. In the drop-down list, select the connected HID-compliant headset. 

 
 

b. Click Connect Headset. 

https://www.cloudone.co/shop/category/yealink-headsets-629
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4. Click Save. 
 

Result 

You can use the HID-compliant headset to handle calls. The supported call operations are 

as follows: 
 

• Answer/Reject a call 
• Answer/Reject a second call 
• End a call 
• Hold/Resume a call 
• Mute/Unmute a call 
• Adjust system volume 

 
 

Tip: 

In case you want to change the connected headset, select another connected 
HID- compliant headset and click Connect Headset. 
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Email Notification 
 

Enable Email Notifications for Missed Calls and Password 
Changes 

This topic describes how to enable email notifications for missed calls and password 

changes. 
 

Procedure 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Features. 

2. In the Notifications section, select the desired checkbox to decide which 
notifications you want to receive. 

 
 

3. Click Save. 
 

Result 

When the corresponding event occurs, the system will send relevant notifications to your 

email address. 
 
 

Call 
 

Handle Incoming Calls Based on Caller ID 

This topic describes how to create a call handling rule to handle incoming calls based on 
incoming Caller ID. 
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Procedure 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Features > Call 
Handling Based on Caller ID. 

2. Click Add to set up a call handling rule. 

a. In the Caller ID field, enter a specific number or a number pattern. 

• To apply the rule to a specific number, enter a specific number. 

For example, enter 10086 to handle incoming calls with Caller ID 
10086 based on the rule. 

• To apply the rule to a number pattern, enter a wildcard pattern. 

For example, enter 9011. to handle incoming calls with any Caller ID 
starting with 9011 based on the rule. 

For more information, see Caller ID Pattern. 

b. In the Action drop-down list, set how you want to deal with incoming calls with 

the Caller ID. 

▪ Hang Up 
▪ Extension 
▪ Voicemail  
▪ IVR 
▪ Play Greeting then Hang up 
▪ Accept Call 

 

Note: 

By default, all incoming calls are allowed to reach your extension. 
If there is a call-handling rule to prevent spam calls 

(eg.728373XX) from reaching your extension, but you want to 
accept calls from a specific number (eg.72837300), you can create 

another rule to accept calls from 72837300. 

c. Click Confirm. 

3. Optional: To add more rules, repeat step 2. 

4. Optional: In the Move column, adjust the rules' order. The rules take effect from 
the top down. 

 

Note: 

For example, set the rule "Accept calls from 72837300" to a higher priority 

than the rule "Reject calls from numbers starting with 728373". In this way, 

https://help.yeastar.com/en/p-series-cloud-edition/administrator-guide/did-pattern-and-caller-id-pattern.html


 

Simu Connect Desktop Client User Guide | 16 - Extension Preferences | 150 

 
 

when receiving calls from 72837300, the system will send calls to your 
extension. For other incoming calls from number starting with 728373, the 
system will hang up directly. 

5. Click Save. 
 

Result 

The call handling rules take effect immediately. When an incoming call reaches your 
extension, PBX will handle the call based on Caller ID accordingly. 
 

Stop Rejected Calls from Ringing Other Endpoints 

If your extension has been registered on multiple endpoints, when you reject an incoming   
call on one of the endpoints, the call keeps ringing all the other endpoints. In this case, you 
can set up your extension to stop rejected calls from ringing other endpoints. 
 

Procedure 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Features. 

2. In the Call section, select the checkbox of All Reject Mode for Endpoints. 

 

3. Click Save. 
 

Result 

When you reject an incoming call on an endpoint, the other endpoints will stop ringing. The 
call will be routed to the preset When Busy destination (Path: Preferences > Presence > 
Call Forwarding). 
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Set up Auto Answer for Non-paging/intercom Calls 

With this auto-answer feature, you can efficiently manage incoming non-paging/intercom 
calls without manually clicking to answer, significantly reducing callers' waiting time. This 
topic describes how to configure auto answer non-paging/intercom calls. 
 

Requirements 

The version of Simu Connect Desktop Client is 1.8.3 or later. 
 

Procedure 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Features. 

2. In the Call section, select the checkbox of Auto Answer, then configure the following 
settings as needed. 

 

• Auto Answer Delay Time(s): Set the delay time in seconds that callers have 
to wait before automatically answering non-paging/intercom calls. 

The valid value is from 0 - 60, and 0 indicates that incoming non-paging/inter- 

com calls will be auto-answered immediately. 

• Play Auto Answer Tone: Enable this option to alert you with a beep tone 
when incoming non-paging/intercom calls are answered automatically. 

3. Click Save. 
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Result 

Non-paging/intercom calls will be auto-answered based on the delay time. 
 

Note: 
 

• Incoming video calls will be auto-answered as audio calls. 

• If you are already on an active call and call waiting is enabled, the new call    
will wait until the current call ends before being auto-answered; otherwise, 
it will be routed to the "When Busy" destination. 

 
 
 

Set up Auto Answer for Paging/Intercom Calls 

With this auto-answer feature, paging and intercom calls will be auto-answered immediately 
without manually clicking. This topic describes how to enable auto-answer for 
paging/intercom calls. 
 

Requirements 

The version of Simu Connect Desktop Client is 1.8.3 or later. 
 

Procedure 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Features. 

2. In the Call section, select the checkbox of Auto Answer Paging/Intercom Call, then 
configure the following settings as needed. 
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• Paging/Intercom Calls Barge In: Enable this option to auto answer incoming 
paging/intercom calls when you are already on an active call. 

• Play Auto Answer Tone: Enable this option to alert you with a beep tone 
when incoming paging/intercom calls are answered automatically. 

3. Click Save. 
 

Result 

Paging/intercom calls will be auto-answered. 
 

Note: 

If you are already on an active call but call waiting is disabled, the new Paging/inter- 

com call will be routed to the "When Busy" destination. 
 
 
 

Call Popup 
 

Automatically Open Contact URL on Incoming Calls 

Cloud One provides a lightweight integration with a third-party application (such as CRM 
system, ERP system, etc.) to achieve call popup via custom popup URL. When your 
extension receives a call, a browser webpage will pop up automatically to display contact 
details. 
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Requirements 
 

• PBX server: Version 84.18.0.59 or later 

• Simu Connect Desktop Client: Version 1.10.2 or later 

• Third-party application: 

◦ Web-based. 

◦ Support to provide a URL that can identify callers via Caller ID and Caller 
ID Name. 

 

Procedure 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Features > Call Popup. 

2. Select the checkbox of Open Contact URL Using Custom Popup URL. 

3. Set up third-party integration via Popup URL. 
 

Setting Description 

Popup URL Enter the third-party URL, followed by the variables that you 
want to pass. 

Supported variables: 

•  . {{ .CallerNumber}}: Incoming Caller ID. 
•  . {{ .CallerDisplayName}}: Incoming Caller ID Name. Take 

Solve360 CRM as an example: 
https://web/solve.360.com/{{.CallerNumber}}&{{.CallerDisplayNa 
me}} 

Communication Type Select which types of calls will trigger the call popup. 

• Inbound: Inbound calls from external users. 

• Internal: Internal calls from colleagues. 

Trigger Event Set when the call popup will be automatically triggered. 

• Ringing: An incoming call reaches. 

• Answered: An incoming call is answered. 

• Call End: An incoming call is ended. 

4. Click Save. 
 

Result 

When your extension receives an incoming call, a browser webpage automatically pops up 

based on the specified call-related events, displaying relevant customer information. 
 

file:///C:/Users/USER/Downloads/84.18.0.59
https://web/solve.360.com/%7b%7b.CallerNumber%7d%7d&%7b%7b.CallerDisplayNa
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Important: 

For the first-time use, you need to allow pop-ups and redirection in your browser, or 

the pop-up screen can NOT be opened automatically. 

 
 
 

Automatically Launch External Applications on Incoming Calls 

Cloud One Simu Connect Desktop Client supports to integrate third-party applications to 
achieve call popup by launching executable application. When your extension receives a 
call, Simu Connect Desktop Client will automatically launch the specified external 
application, and transfer the incoming call information. 
 

Requirements 
 

• PBX server: Version 84.18.0.59 or later. 

• Simu Connect Desktop Client: Version 1.10.2 or later 

• External Application: The desired application(s) have already been installed on 
your local computer. 

 

Procedure 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Features > Call Popup. 

2. Select the checkbox of Launch External Application. 

3. Click Add to add a trigger rule, then complete the following settings. 
 

Note: 

A maximum of 3 trigger rules are supported. 

file:///C:/Users/USER/Downloads/84.18.0.59
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Setting Description 

Trigger Event Set when the external application will be automatically launched. 

• Ringing: An incoming call reaches. 

• Answered: An incoming call is answered. 

• Call End: An incoming call is ended. 

Parameters to Send Enter the parameters that will be sent to the specified application. 
Supported variables: 

•  . {{ .CallerNumber}}: Incoming Caller ID. 
•  . {{ .CallerDisplayName}}: Incoming Caller ID Name. 

Path to Application 
Executable 

Enter the file path where the application is installed on the local 
computer or click Browse to select the desired application. 

For example, enter D:\Download\MicroCRM\MicroCRM.exe. 

4. Click Save. 
 

Result 

When your extension receives a call, the external application is automatically launched 

based on the specified call-related events. 
 
 

Function Key 
 
 

Configure Function Keys 

Function keys allow you to monitor status of specific objects or quickly perform specific 
operations. This topic describes how to configure function keys on Simu Connect Desktop 
Client. 
 

Applications and limitations 

Refer to the following table for the endpoints where function keys can be applied and the 

supported number of function keys for each endpoint. 
 

Supported Endpoint Max. Number of Function Keys 

Simu Connect Desktop Client 120 

Simu Connect Web Client 

Cloud One Simu Connect for Google 

IP phones that support Auto Provisioning Depend on how many line keys your phone 
supports. 
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Procedure 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Function Keys. 

The function keys configured by system administrator for your extension are 
displayed in the list, if any. 

2. Configure function keys according to your needs. 

 

• Type: Select a key type. 
 

Tip: 

For the supported key types, see the table. 

• Value: Configure a desired value based on the key type. 

• Label: Optional. Enter a value to help you identify the function key. 

3. Click Save. 
 

Result 
 

• The function keys are applied to Simu Connect Desktop Client, Simu Connect 
Web Client, and Cloud One Simu Connect for Google. 

You can click 回 at the top toolbar to bring up a mini panel, on which you can monitor 

status of specific objects or quickly perform specific operations via function keys. 
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• If you have registered your extension on an IP phone via Auto Provisioning, the 
phone also automatically applies the changes. 

 

Note: 

For IP phones, the number of programmable function keys depends on how 

many line keys your phone supports. If the number of function keys you assign 
exceeds the number of programmable keys supported by your phone, 

the redundant keys cannot take effect. 
 
 

 
 

Types of function keys 
 

Key Type Function Icon & Description 

N/A No functionality. 

• o: The function key provides no 

functionality until configuration. 
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Key Type Function Icon & Description 

Line Configure line keys for IP 
phone. •   : The key type Line is only available for IP 

phones. 

BLF Monitor the status of a 
specific extension. • : The monitored extension is unregistered. 

• : The monitored extension is online and 
ready for communication. 

• : The monitored extension is away from 
desk. 

• : The monitored extension doesn't want to 
be disturbed, and won't receive any calls. 

• : The monitored extension is currently on 
lunch break. 

• : The monitored extension is on a 
business trip. 

• : The monitored extension is currently off 
work. 

• : The monitored extension receives a call. 

 

Tip: 

To pick up the incoming call to the    
extension on Simu Connect Desktop 
Client, hover your mouse over the 
function key, then click the desired 
incoming call. 

 

• : The monitored extension is in a call. 

• : The monitored extension is held in a call. 

  Note: 

 



 

Simu Connect Desktop Client User Guide | 16 - Extension Preferences | 160 

 

 

Key Type Function Icon & Description 

   

 

The function key doesn't work in an audio 
conference call. 

Speed Dial Speed dial a number. 
•   : Click the icon to place a call to the most 

commonly dialed numbers or extensions. 

Check Voicemail • Monitor the status 
of voicemail. 

• Check voicemail 
messages. 

• : The monitored extension is deleted. 

• : All the voicemails of the monitored 
extension are read. 

• : There are unread voicemails for the 
monitored extension. 

 

Tip: 

To check the voicemail messages on 
Simu Connect Desktop Client, click 
the icon, then enter the voicemail PIN 
code as prompts. 

Check Group 
Voicemail 

• Monitor the status  
of group voicemail 
in shared mode. 

• Check group 
voicemail 

messages. 

• : The monitored group voicemail is 
deleted. 

• : All the voicemails of the monitored group 
voicemail are read. 

• : There are unread voicemails for the 
monitored group voicemail. 

 

Tip: 

To check the group voicemail 

messages on Simu Connect Desktop 
Client, click the icon, then enter the 
group voicemail PIN code as 
prompts. 

Park & Retrieve • Monitor the status    
of a specific parking 
number. 

• Park a call on a 
specific parking 
number. 

• Retrieve a parked  
call from a specific 
parking number. 

•  P : The parking number is invalid. 

•  P : The parking number is available. 

 

Tip: 

You can click the icon to park the    
current call on the parking number. 

•  P : The parking number is occupied. 
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Key Type Function Icon & Description 

   
  Tip: 

You can click the icon to retrieve the 
call. 

    

 

 

Note: 

The function key doesn't work in an audio 
conference call. 

Intercom • Monitor the status 
of a specific 
extension. 

• Place an 

intercom call to 
the monitored 
extension to make  
an announcement. 

• : The monitored extension is unregistered. 

• : The monitored extension is available. 

• : The monitored extension receives a call. 

• : The monitored extension is in a call. 

DTMF Send DTMF signals 
directly instead of 
manually entering the 
numbers each time. 

•   : During a call, click the icon to send 
DTMF signals. 

 

Note: 

The function key doesn't work in an audio 
conference call. 

Agent 

Login/Logout 

• Monitor login status 
  in a specific queue. 
• Log in to or log out  
 of a specific queue. 

• : Not a member in a specific queue. 

• : Log in to a specific queue. 

• : Log out of a specific queue. 

Agent 

Pause/Unpause 

• Monitor service 

status in a specific 
queue. 

• Pause or unpause    
receiving a call from 
a specific queue. 

• : Resume service in a queue. 

• : Pause service in a queue. 

• : Not a member in a specific queue. 

• 器: Not logged in to a specific queue. 

LDAP Directory Quickly access the LDAP 
phonebook to query 
contact information on IP 
phones. 

•   : The key type LDAP Directory is only 
available for IP phones. 

Boss-Secretary Monitor the call status of • As a boss, you can monitor your secretary's 

Feature your boss or secretary. call status: 
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Key Type Function Icon & Description 

  
。 : The secretary is NOT handling any calls 

for you. 

。是: The secretary is answering calls for you. 

。 : The secretary is putting a call on hold, 

waiting for you to answer. 

• As a secretary, you can monitor your boss's call 
status: 

。 : The boss is NOT holding any calls for 

you to resume. 

。 : The boss is putting a call on hold, waiting for 

you to resume. 

Call Forward Quickly enable or disable 
call forwarding for the IP  
phone. 

•  : The key type Call Forward is only 
available for IP phones. 

Action URL Quickly send an HTTP 
GET request to a specified 
URL for reporting specific   
events. 

• : The key type Action URL is only 
available for IP phones. 

 



 

 
 
 

Integration 
 
 

Microsoft Outlook Integration 
 

Microsoft Outlook Integration Overview 

Simu Connect Desktop Client supports to integrate with Outlook for Windows, which allows 
you to make phone calls to your Outlook contacts right from Outlook through Simu Connect 
Desktop Client. This topic describes the requirements and key features of Microsoft Outlook 
integration. 
 

Important: 

Simu Connect macOS Desktop does NOT support integration with Microsoft 
Outlook. 

 

Requirements 

Ensure that your Microsoft Outlook meets the following requirements: 
 

• Client: Outlook for Windows 

• Version: Outlook 2016 or later 

• Operating System: Windows 10, Windows 11 
 

Key features 

The integration of Simu Connect Desktop Client and Outlook provides the following key 
features: 

Make Calls in Outlook 

Launch phone calls to your Outlook contacts directly from Outlook through 

Simu Connect Desktop Client. 

Call Popup 

Automatically bring up the contact's profile on Outlook when you receive an in- 

bound call from an Outlook contact through Simu Connect Desktop Client. 

Call Journal 

All the call activities get logged automatically to Outlook when you end calls 

with Outlook contacts through Simu Connect Desktop Client. 

Automatic Contact Creation 
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Automatically pop up the contact creation page on Outlook when you receive 

or make calls with an unknown number that doesn't match an Outlook contact. 

Related information 

Integrate Simu Connect Desktop Client with Outlook for Windows  

Use Microsoft Outlook Integration 

Disable Microsoft Outlook Integration 
 

Integrate Simu Connect Desktop Client with Outlook for Windows 

This topic describes how to integrate Simu Connect Desktop Client with Outlook for 
Windows. 
 

Important: 

Simu Connect macOS Desktop does NOT support integration with Microsoft 
Outlook. 

 

Requirements 

Ensure that your Microsoft Outlook meets the following requirements: 
 

• Client: Outlook for Windows 

• Version: Outlook 2016 or later 

• Operating System: Windows 10, Windows 11 
 

Step 1. Set up Outlook integration on Simu Connect Desktop Client 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Integration. 

2. Turn on the switch of Enable Outlook Integration. 

 

3. Set up automatic contact creation and call logs synchronization as needed. 
 

Feature Instruction 

Automatic Contact 
Creation 

With automatic contact creation set up, Outlook will automatically 
pop up the contact creation page when you receive or make calls 
with an unknown number that doesn't match an Outlook contact. 

a. Select the checkbox of Create New Contacts 
Automatically. 

b. In the Call Types to Auto-create Contacts drop-down list, 
select when will Outlook pop up the contact creation page. 
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Feature Instruction 

 • Inbound: Inbound call from an unknown number that 
doesn't match an Outlook contact. 

• Outbound: Outbound call to an unknown number that 
doesn't match an Outlook contact. 

Call Logs 

Synchronization 

With call logs synchronization enabled, all the call histories with 
your Outlook contacts will be synchronized to Outlook. 

To enable call log synchronization, select the checkbox of 
Synchronize Call Logs Automatically. 

4. Click Save. 
 

Step 2. Activate Simu Connect add-in on Outlook 
 

1. Open or restart Outlook, go to File > Options. 

 

2. In the pop-up window, click Add-ins and click Go.... 
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3. In the pop-up window, select the checkbox of Cloud One Simu Connect Outlook 
Integration and click OK. 

 

4. In the pop-up window, click Install. 
 

Result 
 

• The integration of Simu Connect Desktop Client and Outlook for Windows is set up. 

• You can make phone calls and utilize call features within Outlook. 
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Use Microsoft Outlook Integration 

This topic shows the usage of the key features that can be achieved after integrating Simu 
Connect Desktop Client with Outlook for Windows. 
 

Make calls in Outlook 

Prerequisites 

Simu Connect Desktop Client stays logged in. 

Procedure 

On your Outlook contact list, right click a contact and select Call with Simu Connect 
Desktop, then decide which number you want to call. Simu Connect Desktop Client 
will automatically pop up and initiate the call. 

 
 
 

Note: 
 

• You can also make calls to your Outlook contacts by right 
clicking the recipient or sender in an email. 
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• Whenever you initiate a call for the first time after restarting 

Outlook for Windows, Simu Connect Desktop Client 
automatically pops up a window to prompt you to authorize it 
for making calls from Outlook. 

 
 
 

Call Popup 

Prerequisites 

Outlook for Windows stays logged in. 

Procedure 

When you receive an inbound call from an Outlook contact, Outlook will pop up 

to show the contact's information. 
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Troubleshooting: 

Simu Connect Desktop Client does NOT display the caller's name? 

If the Simu Connect Desktop Client only displays the phone number when 
receiving calls from your Outlook contacts, you need to contact the system 
administrator to synchronize your Outlook contacts to your app name 

clients. 
 
 

Call Journal 

Prerequisites 

• Outlook for Windows stays logged in. 

• You have enabled call logs synchronization. 
 

Procedure 

All outbound calls, inbound calls, and missed call histories with your Outlook 
contacts will be logged to Outlook automatically, which helps you to keep 
track of every conversation. 

You can log in to Outlook, go to the Notes section in a contact editing page to 

view the call logs. 
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Automatic Contact Creation 

Prerequisites 

• Outlook for Windows stays logged in. 

• You have set up automatic contact creation. 
 

Procedure 

When you receive or make calls with an unknown number that doesn't match    
an Outlook contact, Outlook automatically brings up the contact creation page 
and logs the phone number. You can update other details and save it as your    
Outlook contact. 

 
 

Disable Microsoft Outlook Integration 

This topic describes how to disable the integration of Simu Connect Desktop Client and 
Outlook for Windows. 
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Step 1. Disable Outlook integration on Simu Connect Desktop Client 
 

1. Log in to Simu Connect Desktop Client, go to Preferences > Outlook Integration. 

2. Turn off the switch of Enable Outlook Integration. 

 

3. Click Save. 
 

Step 2. Inactivate Simu Connect add-in on Outlook 
 

1. Log in to Outlook, go to File > Options. 

 

2. In the pop-up window, click Add-ins and click Go.... 
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3. In the pop-up window, unselect the checkbox of Cloud One Simu Connect 
Outlook Integration and click OK. 

 
 

Result 

The integration of Simu Connect Desktop Client and Outlook is disabled, along with all the 
features provided by the Outlook integration. 



 

Simu Connect Desktop Client User Guide | 17 - Integration | 173 

 
 

TAPI Integration 
 

TAPI Integration Guide 
 

Integrate Simu Connect Desktop Client with TAPI 

Cloud One offers a TAPI software driver that can be installed on your PC to seamlessly 
integrate with your Simu Connect Desktop Client (Windows Desktop). This integration 
allows you to implement click-to-call directly from a variety of TAPI-enabled applications 
(such as your CRM  application) using Simu Connect Desktop Client, eliminating the need 
for manual dialing of telephone numbers and thus enhancing productivity. 
 

Note: 

The TAPI integration is available for Simu Connect Desktop Client (Windows 
Desktop) only. 

 

Requirements 
 

• PBX Server: Version 84.17.0.16 or later 

• Simu Connect Desktop Client (Windows Desktop): 1.8.3 or later 

• Windows Operating System: Windows 7, Windows 8, Windows 8.1, Windows 10, 
Windows 11, Windows Server 2008 R2, Windows Server 2012 R2, Windows Server 
2016, and Windows Server 2019 (all 64-bit) 

 

Install the Cloud One TAPI driver 

Download the TAPI driver on Simu Connect Desktop Client and install the driver on your 
PC. 

1. Log in to Simu Connect Desktop Client, go to Preferences > Integration. 

2. At the top-right corner of the TAPI Integration section, click TAPI Driver Download. 
 

file:///C:/Users/USER/Downloads/84.17.0.16
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A Simu Connect TAPISetup.exe file is downloaded to your PC. 

3. Open the Simu Connect TAPISetup.exe to install the TAPI driver. 

a. Select the desired language. 

 

b. Click Install. 

Screen shoot 
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The TAPI driver installation starts. 

c. When finished, click Finish to close the installer program. 

d. In the pop-up window, click OK. 

4. Restart the Simu Connect Desktop Client. 
 

Check the installation result of the Cloud One TAPI driver 

You can check whether the Cloud One TAPI driver is installed successfully on your PC. 
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1. Press Win + R to open the Run command window. 

2. Type telephon.cpl and press Enter to open the Phone and Modem window. 

Under the Advanced tab, if you see the Cloud One TAPI Service Provider 
displayed in the Providers list, it indicates that the Cloud One TAPI driver is installed 
successfully. 

Screen shoot 
 

Make a test call via Cloud One TAPI driver 

Make a test call to verify whether the Cloud One TAPI driver is operational. In this example, 
we use the Windows Dialer app to show how to make a call via Cloud One TAPI driver. 

Prerequisites 

• You have logged in to Simu Connect Desktop Client. 

• The Dial out immediately setting on Simu Connect Desktop Client 
has been enabled. 
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Screen shoot 

• If you have set up default calling app to other driver or app for your 
PC before, you need to change it to your app name. 

 

Procedure 
 

1. On your PC, press Win + R to open the Run command window. 

2. Type dialer.exe, then press Enter to open the Phone Dialer window. 

3. On the top menu, click Tools, then select Connect Using.... 
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4. In the Line drop-down list, select Cloud One TAPI Service Provider, 
then click OK.
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In this way, numbers dialed in the Dialer will be called out through 
this line. 

 

Note: 

When Cloud One TAPI driver is selected as the line, the TAPI 
connectivity on Simu Connect Desktop Client will be 
displayed as Connected. 

5. In the Number to dial field, enter a phone number and click Dial. 

 

Simu Connect Desktop Client is launched, initiating an outgoing call. 
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TAPI Integration Guide (Deutsch) 
 

Integrieren Sie den your app name-Desktop-Client mit TAPI 

Cloud One bietet einen TAPI-Softwaretreiber an, der auf Ihrem PC installiert werden kann, 
um naht los mit Ihrem Simu Connect Desktop Client (Windows Desktop) zu integrieren. 
Diese Integration ermöglicht es Ih nen, einen "Click-to-Call" Anruf direkt aus einer Vielzahl 
von TAPI-fä higen Anwendungen (wie Ihrer CRM-Anwendung) mithilfe des Simu Connect 
Desktop Clients 

zu implementieren. Somit entfä llt manuelles Wählen von Telefonnummern, verringert die 

Fehlerquote und steigert somit die Produktivität. 
 

Note: 

Die TAPI-Integration ist nur für den Simu Connect Desktop Client (Windows 
Desktop) verfügbar. 

 

Anforderungen 
 

• PBX-Server: Version 84.14.0.24 oder neuer 

• Simu Connect Desktop Client (Windows Desktop): 1.4.9 oder neuer 

• Windows-Betriebssystem: Windows 7, Windows 8, Windows 8.1, Windows 10 
und Windows 11 (alle 64-Bit) 

 

Installation des Cloud One TAPI-Treibers 

Laden Sie den TAPI-Treiber auf Ihrem your app name-Desktop-Client herunter und 
installieren Sie den Treiber auf Ihrem PC. 

file:///C:/Users/USER/Downloads/84.14.0.24
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1. Melden Sie sich beim Simu Connect Desktop Client an und gehen Sie zu 
Preferences > Integration. 

2. In der oberen rechten Ecke des Absch nitts TAPI Integration klicken Sie auf TAPI 
Driver Download. 

 

 

Es wird eine Datei mit dem Namen Cloud One TAPISetup.exe auf Ihren PC 
herunterge- laden. 

3. Öffnen Sie die Datei Cloud One TAPISetup.exe, um den TAPI-Treiber zu installieren. 

a. Wählen Sie die gewünschte Sprache aus. 

 

b. Klicken Sie auf Install. 
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Screen shoot 

Die Installation des TAPI-Treibers beginnt. 

c. Wenn die Installation abgeschlossen ist, klicken Sie auf Finish, um das 
Installationsprogramm zu schließen. 

Screen shoot 
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Überprüfen Sie das Installationsergebnis des Cloud One TAPI-Treibers. 

Sie können folgendermaßen überprüfen, ob der Cloud One TAPI-Treiber erfolgreich installiert 

wurde. 
 

Anleitung 

1. Drücken Sie Win + R, um das Fenster "Ausführen" zu öffnen. 
2. Geben Sie telephon.cpl ein und drücken Sie die 

Eingabetaste, um das Fenster Phone and Modem zu öffnen. 

Unter dem Tab Advanced, wenn Sie den your brand name 
TAPI-Dienstanbieter in der Liste der Anbieter sehen, zeigt dies 
an, dass der Cloud One TAPI-Treiber erfolgreich installiert 
wurde. 

1. Öffnen Sie im Simu Connect Desktop-Client die 
Einstellungen und navigieren Sie zu Preferences > 
Integration > TAPI 

Integration. 

 

 
Überprüfen Sie das 

Installationsergebnis auf 

Ihrem PC. 

 
 

Überprüfen Sie die 

TAPI-Konnektivität im your 

app name Desktop-Client. 

 

 

Methode 
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Methode Anleitung 

 
2. Im Statusfeld klicken Sie auf  , um denVerbindungsstatus 

zu aktualisieren. 

Wenn der Status als Connected angezeigtwird, deutet dies    
darauf hin, dass der Cloud One TAPI-Treiber erfolgreich 
installiert wurde. 

 

 

Führen Sie einen Testanruf über den Cloud One TAPI-Treiber durch 

Füh ren Sie einen Testanruf durch, um zu ü berprüfen, ob der Cloud One TAPI-Treiber 
funktion- iert. In diesem Beispiel verwenden wir die Windows-Wähl-App, um zu zeigen, wie 
ein Anruf ü ber den Cloud One TAPI-Treiber getätigt wird. 

Voraussetzungen: 

• Sie haben sich im Simu Connect Desktop-Client angemeldet. 

• Die Funktion Dial out immediately im Simu Connect Desktop-Client 
wurde ak- tiviert. 

 

• Wenn Sie zuvor eine andere Standardanruf-App oder einen anderen 

Treiber für Ih ren PC eingerichtet haben, müssen Sie diese auf Simu 
Connect än- dern. 

 

Vorgehensweise 

1. Drücken Sie auf Ihrem PC Win + R, um das Fenster "Ausführen" zu 
öff- nen. 
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2. Geben Sie dialer.exe ein und drücken Sie dann die Enter, um das Fen- 
ster Phone Dialer zu öffnen. 

3. Klicken Sie im o beren Menü auf Tools, und wählen Sie dann 
Connect Using.... 

 

4. Wählen Sie im Dropdown-Menü Line den Eintrag Cloud One TAPI 
Service Provider aus und klicken Sie dannauf OK. 
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Auf diese Weise werden die im Dialer gewählten Nummern über 
diese Leitung angerufen. 

5. Geben Sie im Feld Number to dial eine Telefonnummer ein und 
klicken Sie dannauf Dial. 
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